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This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
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of the US. Government, the following notice is applicable:

US. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication,
disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the
applicable Government contract, and, to the extent applicable by the terms of the Government contract, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007).
Oracle America, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications.
It is not developed or intended for use in any inherently dangerous applications, including applications which
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe
use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software
or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be
trademarks of their respective owners.

This software or hardware and documentation may provide access to or information on content, products,
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly
disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle
Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your
access to or use of third-party content, products, or services.

NOTIFICATION OF THIRD-PARTY LICENSES

Oracle Utilities softwate contains third party, open source components as identified below. Third- party license
terms and other third-party required notices are provided below.

License: Apache 1.1

Module: Crimson v1.1.1, Xalan ]2

Copyright © 1999-2000 The Apache Software Foundation. All rights reserved.

Use of Crimson 1.1.1 and Xalan J2 within the product is governed by the following (Apache 1.1):

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) The end-user documentation included with the redistribution, if any, must include the
following acknowledgment: “This product includes software developed by the Apache Software Foundation
(http://www.apache.org/) . Alternately, this acknowledgment may appear in the software itself, if and
wherever such third-party acknowledgments normally appear. (4) Neither the component name nor Apache



Software Foundation may be used to endorse or promote products derived from the software without specific
prior written permission. (5) Products derived from the software may not be called “Apache”, nor may
“Apache” appear in their name, without prior written permission.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

License: CoolServlets.com

Module: CS CodeViewer v1.0 (Sun JRE Component)

Copyright © 1999 by CoolServlets.com

Use of this module within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/ot other matetials provided with the
distribution. (3) Neither the component name nor Coolservlets.com may be used to endorse or promote
products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY COOLSERVLETS.COM AND CONTRIBUTORS “AS IS” AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

License: Justin Frankel, justin@nullsoft.com
Module: NSIS 1.0j (Sun JRE Component)
Use of this module within the product is governed by the following:

(1) The origin of the module must not be misrepresented, and Oracle may not claim that it wrote the original
software. If Oracle uses this module in a product, an acknowledgment in the product documentation is
appreciated but not required. (2) Altered source versions of the module must be plainly marked as such, and
must not be misrepresented as being the original software. (3) The following notice may not be removed or
altered from any source distribution: “Justin Frankel justin@nullsoft.com”.

License: ICU4j License
Module: ICU4j
Copyright © 1995-2001 International Business Machines Corporation and others. All rights reserved.

Oracle may use the software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, and/ort sell copies of the softwate, and to permit persons to whom the software is
furnished to do so, provided that the above copyright notice and the permission notice appear in all copies of
the software and that both the above copyright notice and the permission notice appear in supporting
documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL



DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

License: Info-ZIP

Module: INFO-ZIP ZIP32.DLL (Binary Form)

Copyright (c) 1990-2005 Info-ZIP. All rights reserved

Use of this dll within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
definition and disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the definition and disclaimer below in the documentation and/or other materials
provided with the distribution. The sole exception to this condition is redistribution of a standard UnZipSFX
binary (including SFXWiz) as part of a self-extracting archive; that is permitted without inclusion of this
license, as long as the normal SFX banner has not been removed from the binary or disabled. (3) Altered
versions--including, but not limited to, ports to new operating systems, existing ports with new graphical
intetfaces, and dynamic, shated, or static library versions--must be plainly marked as such and must not be
misrepresented as being the original source. Such altered versions also must not be misrepresented as being
Info-ZIP releases--including, but not limited to, labeling of the altered versions with the names “Info-ZIP” (or
any variation thereof, including, but not limited to, different capitalizations), “Pocket UnZip,” “WiZ” or
“MacZip” without the explicit permission of Info-ZIP. Such altered versions are further prohibited from
misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s). (4) Info-ZIP
retains the right to use the names “Info-ZIP” “Zip,” “UnZip,” “UnZipSFX,” “WiZ,” “Pocket UnZip,” “Pocket
Zip,” and “MacZip” for its own source and binary releases.

[Definition]: For the purposes of this copyright and license, “Info-ZIP” is defined as the following set of
individuals:

Mark Adler, John Bush, Karl Davis, Harald Denket, Jean-Michel Dubois, Jean-loup Gailly, Hunter Goatley, Ed
Gordon, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul
Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller, Sergio
Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven
M. Schweda, Christian Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White

[Disclaimer:] “This software is provided “as is,” without warranty of any kind, express or implied. In no event
shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential
damages arising out of the use of or inability to use this software.”

License: Paul Johnston

Modules: md5.js

Copyright (C) Paul Johnston 1999 - 2002

Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) Neither the component name nor the names of the copyright holders and contributors may be
used to endorse or promote products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.



License: Jef Poskanzer

Modules: DES, 3xDES (Sun JRE Components)

Copyright © 2000 by Jef Poskanzer <jef@acme.com>. All rights reserved
Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other materials provided with the
distribution. (3) Neither the component name nor the name of Jef Poskanzer may be used to endorse or
promote products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

License: Sun Microsystems, Inc.

Modules: Sun Swing Tutorials

Copyright© 1995-2006 Sun Microsystems, Inc. All Rights Reserved.
Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) Neither the component name nor the name of Sun Microsystems, Inc. and contributors may
be used to endorse or promote products derived from the software without specific prior written permission.
(4) Oracle must acknowledge that the software is not designed, licensed or intended for use in the design,
construction, operation or maintenance of any nuclear facility.

THIS SOFTWARE IS PROVIDED “AS 1S,” WITHOUT A WARRANTY OF ANY KIND. ALL EXPRESS
OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR
NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. (“SUN”) AND ITS
LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A
RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES.
IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT
OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR
PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF
SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

License: Tom Wu

Module: jsbn library

Copyright © 2003-2005 Tom Wu. All rights teserved

Use of this module within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other materials provided with the
distribution.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL TOM
WU BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES



OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY
THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
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What’s New

New Features in the Oracle Utilities Energy
Information Platform Installation Guide

This chapter outlines the new features of the 1.6.0.0 release of the Oracle Utilities Energy

Information Platform that are documented in this guide.

New Features for Release 1.6.0.0

Feature

Description

For more information, refer to...

Support for Oracle Business
Intelligence Publisher

This release includes support for
publishing reports using Oracle Business
Intelligence Publisher 10.1.3.4.

Installing Oracle Business Intelligence
Publisher on page 2-16

Configuring Oracle BI Publisher on
page 2-17

Support Oracle 10g RAC

This release includes support for the use of
Oracle 10g Release 2 (10g R2) Real
Application Clusters (RAC) with database
servers.

Oracle 10g Release 2 Real Application
Cluster (RAC) on page 2-12







Chapter 1

Overview

This chapter provides an overview of the installation of the Oracle Utilities Energy Information
Platform, including:

. Installation Overview
¢ What is this book?

*  The Oracle Utilities Energy Information Platform Installation Package
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Installation Overview

Installation Overview

Installing the Oracle Utilities Energy Information Platform involves the following steps:

*  Setup the Energy Information Platform Network Environment and the Oracle Ultilities Data
Repository as described in Chapter 2: Setting Up the Network Environment and Chapter
3: Oracle Utilities Data Repository Schema Creation of the Oracle Utilities Energy
Information Platform Installation and Confignration Guide.

*  Install workstation and application server applications used by the Energy Information
Platform on server and client machines as described in Chapter 4: Installing the Oracle
Utilities Application Software.

*  Install Energy Information Platform web components on web server as described in
Chapter 4: Installing the Oracle Utilities Application Software.
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What is this book?

What is this book?

This book describes how to install the Oracle Utilities Energy Information Platform, including the
following:

*  Chapter 1: Overview (this chapter) provides an overview of the Energy Information
Platform installation and configuration process

*  Chapter 2: Setting Up the Network Environment describes the hardware components
used by Energy Information Platform.

*  Chapter 3: Oracle Utilities Data Repository Schema Creation describes how to create
the Oracle Utilities Data Repository database schema.

*  Chapter 4: Installing the Oracle Utilities Application Software describes how to install
Energy Information Platform application software on an application server, on a web server,
and on client machines.
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The Oracle Utilities Energy Information Platform Installation Package

The Oracle Utilities Energy Information Platform Installation
Package

There is a separate installation package for the Oracle Utilities Energy Information Platform and
for each related product. The table below provides the installation package file names for the
Oracle Utilities Energy Information Platform and for each related product.

Product Installation File Name
Oracle Utilities Energy Information Platform 01.06.10.xx.00.EIP.zip
Oracle Utilities Billing Component 01.06.10.xx.00.BC.zip
Oracle Utilities Load Profiling and Settlement 01.06.10.xx.00.LPS.zip
Oracle Utilities Meter Data Management 01.06.10.xx.00.MDM.zip
Oracle Utilities Quotations Management 01.06.10.xx.00.QM.zip
Oracle Utilities Rate Management 01.06.10.xx.00.RM.zip
Oracle Utilities Transaction Management 01.06.10.xx.00. TM.zip

The Oracle Utilities Energy Information Platform installation package contains the following
folders:

e Install: Contains the installation program for the Oracle Utilities Energy Information
Platform, including:

. Oracle Utilities EIP 01.06.10.xx.00.msi
*  sctup.exe

e DBScripts: Contains database creation scripts for the Oracle Utilities Energy Information
Platform, including:

¢ Buildora.cmd
*  Other database script files

*  Documentation: Contains documentation for the Oracle Ultilities Energy Information
Platform, including:

*  Oracle Utilities Energy Information Platform Installation Guide

*  Oracle Utilities Energy Information Platform Configuration Guide
*  Oracle Utilities Energy Information Platform User’s Guide

*  Data Manager User’s Guide

*  Oracle Utilities Rules Language User’s Guide

*  Oracle Utilities Rules Language Reference Guide

1-4 Energy Information Platform Installation Guide



Chapter 2

Setting Up the Network Environment

This chapter describes how to set up and configure the network environment in which the Oracle
Utilities software will be installed. This includes:

*  Oracle Utilities Platform Components Specifications

*  Sample Platform Configurations

*  Application and Web Service Configuration

* Installing Relational Database Management System Software

* Installing and Configuring Reporting Software

Setting Up the Network Environment 2-1



Oracle Utilities Platform Components Specifications

Oracle Utilities Platform Components Specifications

This section contains options for hardware and software specifications for implementation of the

Oracle Utilities Energy Information Platform and related products, including:
*  Oracle Utilities Billing Component

*  Oracle Utilities Load Analysis

*  Oracle Utilities Load Profiling and Settlement

*  Oracle Utilities Meter Data Management

*  Oracle Utilities Quotations Management

*  Oracle Utilities Rate Management

*  Oracle Utilities Transaction Management

The Energy Information Platform application architecture comprises all of the components
typically found in any n-tier enterprise architecture, including client machines, servers, and the
supporting network infrastructure.

The Oracle Utilities Energy Information Platform uses five primary types of systems components.
Suggested hardware specifications and required software for each component are listed below.

Before installing Oracle Utilities software you should consult with Oracle Utilities Consulting.
They will make suggestions for your hardwate and network architecture based on your business
requirements. You should also consult with Oracle Utilities Consulting if your business
requirements change, if your database grows significantly, or if you plan on migrating to a different
version of Oracle Utilities software.

Note: Supported software versions are subject to change. Please refer to the
Release Notes shipped with the software for the latest supported versions.

2-2 Energy Information Platform Installation Guide



Oracle Utilities Platform Components Specifications

Client Workstation - C/S

These are wotkstations used when running the client/setrver (C/S) versions of Oracle Utilities
applications, such as Data Manager.

Hardware Minimum Requirements

CPU Intel® Pentium® series (2 core per CPU, 1.6 GHz minimum)
Memory 2GB or higher

Disk Drive 80GB SATA 7200RPM

Network 100 MB/s ot higher

Software for Client Workstation - C/S:
*  Supported Operating Systems

*  Microsoft Windows XP Professional with Service Pack 3 (SP3) or higher
*  Microsoft Windows Vista Business with Service Pack 1 (SP1)
*  Supported Web Browsers
*  Microsoft Internet Explorer 6 with latest security updates; Service Pack 3 or higher
*  Microsoft Internet Explorer 7 with latest security updates

*  Relational Database Management System (RDBMS) client with applicable ODBC driver and
Data Provider for NET

*  Oracle Utilities Energy Information Platform software

*  Microsoft NET Framework 3.5

*  Microsoft Data Access Component (MDAC) 2.8 or higher
*  Microsoft XML Core Services (MSXML) 4.0 SP2 or higher

Setting Up the Network Environment 2-3



Oracle Utilities Platform Components Specifications

Client Workstation - Web

These are workstations used when running the web-enabled versions of Oracle Utilities
applications only.

Hardware Minimum Requirements

CPU Intel® Celeron® series (2 cote per CPU, 1.6 GHz minimum)
Memory 1GB or higher

Disk Drive 80GB SATA 7200RPM

Network 100 MB/s

Software for Client Workstation - Web:
*  Supported Operating Systems

*  Microsoft Windows XP Professional with Service Pack 3 (SP3) or higher
*  Microsoft Windows Vista Business with Service Pack 1 (SP1)
*  Supported Web Browsers
*  Microsoft Internet Explorer 6 with latest security updates; Service Pack 3 or higher

*  Microsoft Internet Explorer 7 with latest security updates

Note: For users that require access to both cilent/server and web browser-based applications
q PP s
please refer to the requirements listed for "Client Workstations - Thick Client."
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Oracle Utilities Platform Components Specifications

Database Server

The database server houses the Oracle Utilities Data Repository. The hardware platform for the
database server may be Windows/Intel or UNIX/RISC.

Hardware Minimum Requirements

CPU 2 x Intel® Xeon® 5000 series or RISC based (2 cote per CPU, 2.0
GHz minimum)

Memory 16GB or higher

Disk Drive 2 x 72GB 15k rpm SCSI or better (system disk)

Data Storage External Network Storage

Disk Controller RAID

Network 2 x Gigabit Ethernet or higher

Software for Database Server:
*  Supported Operating Systems

*  Microsoft Windows Server 2003, Microsoft Windows Server 2008, LINUX (UNIX/
Intel), Sun Microsystems Solaris, HP-UX, or IBM AIX (UNIX/RISC) software

*  RDBMS server - Oracle or Microsoft SQL Server

Database Platforms:
*  Oracle 10g, Release 2

*  Oracle 11g, Release 1
*  Oracle 11g, Release 2
*  Microsoft® SQL Server 2008

Note: Supported database versions and drivers are subject to change. Please refer to the Oracle
Release Notes shipped with the software for the latest compatibility matrix.
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Oracle Utilities Platform Components Specifications

Application/Batch Processing Server

Application servers are used when running Windows Services, such as those employed by the
Reporting Framework and Workflow Management components. The application server(s) can also
perform batch processes such as meter data upload and validation as well as batch billing and

settlements.
Hardware Minimum Requirements
CPU 2 x Intel® Xeon® 3000 series (2 core per CPU, 2.0 GHz
minimum)
Memory 8GB or higher
Disk Drive 2x 72 GB 10k rpm SCSI or better
Disk Controller RAID
Network 2x Gigabit Ethernet or higher

Software for the Application/Batch Server:
*  Supported Operating Systems

*  Windows 2003 Enterprise Server R2 with Service Pack 2 (SP2) or higher (32-bit and 64-
bit)

*  Windows 2008 Enterprise Server with Service Pack 2 (SP2) (64-bit)

*  Supported Web Browsers
*  Microsoft Internet Explorer 6 with latest security updates; Service Pack 3 or higher
*  Microsoft Internet Explorer 7 with latest security updates

*  RDBMS client with applicable ODBC driver and Data Provider for NET

*  Oracle Utilities Energy Information Platform software

*  Microsoft NET Framework 3.5

*  Microsoft Data Access Component (MDAC) 2.8 or higher

*  Microsoft XML Core Services (MSXML) 4.0 SP2 or higher

2-6 Energy Information Platform Installation Guide



Oracle Utilities Platform Components Specifications

Web Server(s)

Web servers run Microsoft Internet Information Service (IIS). These servers may be combined
with the application server(s) for combination Web and Application servers.

Hardware Minimum Requirements

CPU 2 x Intel® Xeon® 3000 series (2 core per CPU, 2.0 GHz
minimum)

Memory 8GB or higher

Disk Drive 2x 72 GB 10k rpm SCSI or better

Disk Controller RAID

Network 2x Gigabit Ethernet or higher

Software for Web Server(s):
*  Supported Operating Systems

*  Windows 2003 Enterprise Server R2 with Service Pack 2 (SP2) or higher (32-bit and 64-
bit) with Microsoft Internet Information Service (IIS) 6.0

*  Windows 2008 Enterprise Server with Service Pack 2 (SP2) (64-bit) with Microsoft
Internet Information Service (IIS) 7.0

Note: The 11S6 Management Capability option (including IIS6 Metabase Compatibility,
1IS6 WMI Compatibility, IIS6 Scripting Tools, and 1IS6 Management Console) must be
installed when using IIS on Windows 2008.

*  Supported Web Browsers
*  Microsoft Internet Explorer 6 with latest security updates; Service Pack 3 or higher
*  Microsoft Internet Explorer 7 with latest security updates

*  RDBMS client with applicable ODBC driver and Data Provider for NET

*  Oracle Utilities Energy Information Platform software

*  Microsoft NET Framework 3.5

*  Microsoft Data Access Component (MDAC) 2.8 or higher

*  Microsoft XML Core Services (MSXML) 4.0 SP2 or higher
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Sample Platform Configurations

This section outlines sample platform configurations for several different Oracle Ultilities
products. Each configuration comprises different sets of the Oracle Ultilities system components
described above. Note that these are provided as examples only. Listings of client workstations are
followed by the types of users expected to use the workstation. This includes End Users and
System and Security Administrators.

Oracle Utilities Billing Component, Oracle Utilities Rate Management

This configuration applies to the C/S versions of Oracle Utilities Billing Component or Oracle
Utilities Rate Management. It includes only C/S applications, and consists of the following
components:

*  Database Server
*  Application/Batch Processing Server

*  One or more Client workstations (C/S) [End users and System Administration]

Oracle Utilities Billing Component with Oracle Utilities Receivables
Component

This configuration includes using the C/S version of Oracle Utlities Billing Component with the
Oracle Utilities Receivables Component, and consists of the following components:

*  Database Server

*  Application/Batch Processing Server

*  Web Server

*  One or more Client workstations (C/S) [End users and System Administrators]

*  One or more Client workstations (Web) [End users and Security Administrators]

Oracle Utilities Billing Component Web, Oracle Utilities Quotations
Management (web)

This configuration includes primarily web applications, and consists of the following components:
*  Database Server

*  Application/Batch Processing Server

*  Web Server

*  One or more Client workstations (Web) [End Users and Security Administrators]

*  One or more Client workstations (C/S) [System Administrators]
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Application and Web Service Configuration

This section outlines a number of configuration steps that must be performed on application and

web servers prior to installing the Oracle Utilities software.

Configuration Steps for Windows 2003

When installing on Windows 2003, the version of ASPNET must be set to 2.0.5.0727. Use the
following procedure to set this version of ASPNET.

1.

2
3
4
5.
6
7
8

Select Start->Administrative Tools->Internet Information Services (IIS) Manager.
Click on the plus (+) sign next to your server to expand your server.

Expand Web Sites by clicking on the plus (+) sign.

Right-click Default Web Site and select Properties.

Select the ASP.NET tab.

Select 2.0.50727 on the ASPNET version drop-down list.

Click Apply.

Restart the 11IS service.

Configuration Steps for Windows 2008

When installing on Windows 2008 (64-bit), you must configure the server to run the Oracle
Utilities software in 32-bit mode.

Use the following procedure to perform this configuration.

1.

2
3.
4
5

10.

11.
12.

13.
14.
15.

Select Start->Administrative Tools->Internet Information Services (IIS) Manager.
Click on the plus (+) sign next to your server to expand your server.
Expand Web Sites by clicking on the plus (+) sign.

Select Default Web Site.

Click Basic Settings in the Actions box in the upper right of the page.
The Edit Site dialog opens.

Click Select.

The Select Application Pool dialog opens.

Select Classic .NET AppPool from the Application Pool drop-down list.
Click OK to close the Select Application Pool dialog,

Click OK to close the Edit Site dialog.

Select Application Pools on the Internet Information Services Manager screen (under your
server).

Select Classic .NET AppPool from the list of application pools in the center of the screen.
Click Advanced Settings in the Edit Application Pool box in the upper right of the page.
The Advanced Settings dialog opens.

Set Enable 32-bit Applications to True (in the General section of the dialog).

Click OK to close the Advanced Settings dialog.

Exit the Internet Information Services (IIS) Manager.
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Installing Relational Database Management System Software

This section describes installation and setup of Relational Database Management System
(RDBMS) application software on the database server, application server, and client machine(s),
including:

*  Setting Up the Relational Database Connection

*  Oracle Database Connectivity

*  Oracle 10g Release 2 Real Application Cluster (RAC)

*  MS SQL Server JDBC Driver

The Oracle Utilities Energy Information Platform supports the following RDBMS:
*  Oracle 10g (R2), 11g (R1), 11g (R2)

*  MS SQL Server 2008

Later versions of these RDBMS are generally supported when proven stable through Quality
Assurance testing at Oracle. Please contact technical support for information on which RDBMS
versions are currently supported.

Setting Up the Relational Database Connection

Before the Oracle Utilities application software can be installed, a relational database connection
must be established between the database server and the application server and client machines.
This section explains how to set up this connection.

Important Note!
Setting up the relational database connection is a critical step in installing and implementing
Oracle Ultilities software. Without a working database connection, the software cannot function
propetly. Consult with your I'T department and Database Administrator (DBA) when
performing the following steps.

How to set up a relational database connection for Oracle Utilities software:

1. Install the appropriate RDBMS server software on the database server. Refer to installation
information for your RDBMS for more information.

2. Install the RDBMS client software on the application server and client machines.

3. Create a database connection between the database server and a client machine using
RDBMS client software.

4. Create the Oracle Utilities Data Repository schema on the database server. See Chapter 3:
Oracle Utilities Data Repository Schema Creation for more information.

5. Create user IDs for each client you need in the database, and assign PWRLINE_USER roles
to each.

Note: The PWRLINE_USER role is created when you create the Oracle
Utilities schema on the database server.

6. Create Data Source Names (DSNs) for the Oracle Utilities Data Repository schema on each
machine and test the connection to the server.
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Oracle Database Connectivity

This release uses both Oracle Data Provider (ODP) and ODBC for database connectivity.

ODBC is requited when running database creation and/or upgrade sctipts, and when using
Business Objects® Crystal Reports® reporting softwate.

*  ODRP is required for all other database connectivity.

Oracle Data Provider (ODP) Information

This release requires Oracle Data Provider for NET 3.5. The specific version for each Oracle
version is as follows:

Oracle Database Oracle Data Provider
Version Version
10g 2.102.4.0
11g 2.111.7.0

When installing Oracle 10g database software, use the following procedure:
*  Install the 10.2.0.1 client

*  Install ODP 2.0 10.2.0.2.20 (or 10.2.0.2.21 on Vista)

*  Install the 10.2.0.4 patch, which also patches the ODP

ODBC Driver Information

Below is a matrix of the ODBC driver versions, database versions and the operating systems
supported by the Oracle Utilities products included in this release:

Oracle Database

. ODBC Version
Version
10g 10.2.0.4
11g 11.1.0.7

ODBC Driver Configuration

To propetly configure your Oracle ODBC driver, open the Data Sources (ODBC) Control Panel,
select the System DSN tab, and double-click on the appropriate data source (DSN). Select the
Application tab, see to it that "Enable Query Timeout" is not selected.
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Oracle 10g Release 2 Real Application Cluster (RAC)

This release supports the use of Oracle 10g Release 2 (10g R2) Real Application Clusters (RAC)
with the database servers. This section outlines specific steps involved in configuring your
environment to work with Oracle 10g R2 RAC.

Installing Oracle 10g Release 2 RAC
Install the Oracle 10g R2 RAC software as described in the Oracle Database Oracle Clusterware and
Oracle Real Application Clusters Installation Guide 10g Release 2.

Application/Web Server Configuration for Oracle 10g R2 RAC

This section outlines application/web server configuration tasks required when using Oracle 10g

R2 RAC.

TNS Names File
The TNS Names file (tnsnames.ora) on each application server, web server, and client workstation
must specify the RAC node names within the TNS entry being referenced by the Energy
Information Platform software. Specifically, the HOST attributes (within the ADDRESS
attributes) must be set to the machine name of the nodes (database servers) in the cluster. The

following example illustrates how you might specify the node names for 2 nodes in a cluster
(nodel and node?2).

racdb =
(DESCRIPTION =
(LOAD BALANCE = ON)
(ADDRESS = (PROTOCOL = TCP) (HOST = nodel-vip) (PORT = 1521))
(ADDRESS = (PROTOCOL = TCP) (HOST = node2-vip) (PORT = 1521))
(

CONNECT DATA =
(SERVER = DEDICATED)
(SERVICE_NAME = racdb)
)
)

In addition, a “failover” entry with the same SERVICE_NAME attribute must also be included in
the TNS Names file. The following example illustrates how you specify the node names for 2
nodes in a cluster (nodel and node2) in the “failover” entry.

failover =
(DESCRIPTION =
(enable=broken)
(LOAD BALANCE = ON)
(ADDRESS = (PROTOCOL = TCP) (HOST = nodel-vip) (PORT = 1521))
(
(

ADDRESS = (PROTOCOL = TCP) (HOST = node2-vip) (PORT 1521))
CONNECT_ DATA =

(SERVER = DEDICATED)

(SERVICE NAME = racdb)

(failover mode=(type=select) (method=basic))

)

Hosts File
The Hosts file on each application server, web servert, and client workstation must be edited to
specify the RAC node names. This file is located in the C:\Windows\System32\dtivers\etc
directory. Each node should be listed in the following format at the bottom of the file:

<virtual_ ip> <node_ name>-vip
where:
*  <virtual_ip> is the virtual IP address of the node, as defined in the RAC installation

* <node_name> is the name of the node (database server) in the cluster that are to be
accessed by the Adapter.
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The following example illustrates how node names for 2 nodes in a cluster (nodel and node2)
might be listed in this file.

Copyright (c) 1993-1999 Microsoft Corp.
This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

#

#

#

#

# This file contains the mappings of IP addresses to host names. Each
# entry should be kept on an individual line. The IP address should

# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.

#

# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a '#' symbol.

#
#
#
#
#

For example:

102.54.94.97 rhino.acme.com # source server
38.25.63.10 X.acme.com # x client host
127.0.0.1 localhost

10.159.172.22 nodel-vip
10.159.172.23 node2-vip

Energy Information Platform Configuration for Oracle 10g R2 RAC
This section outlines Energy Information Platform configuration tasks required when using
Oracle 10g RAC.

LTMH.CFG.XML Configuration File
The LTMH.CFG.XML configuration file on each application server and web server that will be
running the Energy Information Platform Adapter must be edited to specify the TNS entry for
the RAC connection in the JDBC connection section. The following example illustrates the
specific elements and attributes that must be populated.

<LTMH JMSENABLED="false">

<!-- Connection for an Oracle database -->

<JDBC URL="jdbc:oracle:thin:@(DESCRIPTION = (LOAD BALANCE =
ON) (ADDRESS = (PROTOCOL = TCP) (HOST = <HOST_NAME>) (PORT = <PORT>)) (ADDRESS =
(PROTOCOL = TCP) (HOST = <HOST_NAME>) (PORT = <PORT>)) (CONNECT_ DATA =
(SERVICE NAME = racdb)))">

<DRIVER TYPE="ORACLE">oracle.jdbc.OracleDriver</DRIVER>
<QUALIFIER>tr450</QUALIFIER>
<USERNAME>tr450</USERNAME>
<PASSWORD>password</PASSWORD>

</JDBC>

</LTMH>
where:

*  <HOST_NAME?>: is the name of the node (database server) in the cluster that are to be
accessed by the Adapter.

*  <PORT?> is the port the database connection will use. Default is 1521.

SeeLTMH.CFG.XML on page 2-45 in the Oracle Utilities Energy Information Platform Configuration
Guide for more information about this configuration file.
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LSReportMonitor.CFG. XML Configuration File
The LSReportMonitor. CFG. XML configuration file on each application server and web server
that will be running Crystal Reports or BI Publisher reports must be edited to specify the TNS
entry for the RAC connection in the Alternate database connection section. The following
example illustrates the specific elements and attributes that must be populated.

<LSREPORTMONITOR>
<DATASOURCE>
<NAME>QA Only</NAME>
<CONNECTSTRING>Data Source=racdb;User
ID=1s106d;Password=lodestar; LSProvider=0DP; </CONNECTSTRING>
<QUALIFIER>1s106d</QUALIFIER>
</DATASOURCE>
<ALTERNATES>
<CONNECTSTRING NAME="QA Only" REPORTTYPE="BIPublisher"> (DESCRIPTION =
(LOAD BALANCE = ON) (ADDRESS = (PROTOCOL = TCP) (HOST = <HOST_NAME>)(PORT =
<PORT>) ) (ADDRESS = (PROTOCOL = TCP) (HOST = <HOST_ NAME>) (PORT =
<PORT>) ) (CONNECT DATA = (SERVER = DEDICATED) (SERVICE NAME = racdb)))</
CONNECTSTRING>
</ALTERNATES>

</LSREPORTMONITOR>

where:

*  <HOST_NAME>: is the name of the node (database server) in the cluster that are to be
accessed by Crystal Reports.

*  <PORT> is the port the database connection will use. Default is 1521.

SeecLSREPORTMONITOR.CFG.XML on page 2-35 in the Oracle Utilities Energy Information
Platform Configuration Guide for more information about this configuration file.

Oracle Bl Publisher Configuration for Oracle 10g R2 RAC
This section outlines Oracle BI Publisher configuration tasks required when using Oracle 10g
RAC.

Data Source Connection String
The Connection String of the Data Source must specify the TNS entry for the RAC connection.
The following example illustrates the correct syntax for the Connection String:

jdbc:oracle:thin:@ (DESCRIPTION = (LOAD BALANCE = ON) (ADDRESS = (PROTOCOL =
TCP) (HOST = <HOST_NAME>) (PORT = <PORT>)) (ADDRESS = (PROTOCOL = TCP) (HOST =
<HOST_NAME>) (PORT = <PORT>)) (CONNECT DATA = (SERVICE NAME = racdb)))

where:

*  <HOST_NAME> is the name of the node(s) (database servers) in the cluster that ate to be
accessed by the Adapter.

. <PORT> is the port the database connection will use. Default is 1521.
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MS SQL Server JDBC Driver

When using MS SQL Server 2008, you must install a Java Database Connectivity (JDBC) 2.0 driver
on each application server and web server that will be running the Energy Information Platform
Adapter. The driver MUST be JDBC 2.0 compliant.

Energy Information Platform Configuration
This section outlines configuration tasks required when using a non-Oracle JDBC driver.

Adapter - System Properties
The System Properties records for all Adapter servers must be updated to reflect the JDBC driver
being used. Specifically, the Class Path of each System Properties record must be edited to include
the .jar file of the JDBC driver. The following example highlights the Class Path of the Oracle
JDBC driver:

.\portal.jar;.\ltmh.jar;.\lsice.jar;.\CustomerBusinessRules.jar;.\lib\jms.jar;
.\lib\tibjms.jar;.\lib\com.ibm.mg.jar;.\lib\com.ibm.mgjms.jar;.\lib\xercesImpl
.jar;.\lib\xalan.jar;.\lib\xml-

apis.jar; .\lib\ojdbcl4.jar;.\lib\fscontext.jar;.\lib\providerutil.jar;.\lib\co
mmons-cli-1.0.jar;.\lib\commons-lang-2.0.jar

See System Properties on page 11-12 in the Oracle Utilities Energy Information Platform Users Guide
for more information about editing System Properties records.

LTMH.CFG.XML Configuration File
The LTMH.CFG.XML configuration file on each application server and web server that will be
running the Energy Information Platform Adapter must be edited to specify the JDBC driver.
The JDBC Oracle section should be commented out or removed from the file, and the JDBC
SQL Server section must be populated. The following example illustrates the specific elements
and attributes that must be populated.

<LTMH JMSENABLED="false">

<!-- Connection for a SQL Server database -->

<!-- A SQL Server JDBC driver can be obtained from http://
jtds.sourceforge.net -->

<JDBC URL="{DRIVER_URL)!//(SERVERNAME}/{DATABASE}">
<DRIVER TYPE="SQLSERVER">{DRIVER_CLASS_PATH}</DRIVER>
<USERNAME>{DATABASE USERNAME }</USERNAME>
<PASSWORD>{DATABASE PASSWORD}</PASSWORD>
</JDBC>
</LTMH>
where:

+ {DRIVER_URL} is the URL of the JDBC driver. Consult your dtivet’s documentation for
proper composition.

+ {DRIVER_CLASS_PATH} is the full classpath of the JDBC driver.

SeeLTMH.CFG.XML on page 2-45 in the Oracle Utilities Energy Information Platform Configuration
Guide for more information about this configuration file.
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Installing and Configuring Reporting Software

This release of the Energy Information Platform provides reporting capabilities through Crystal
Reports 2008 (Service Pack 2) and Oracle Business Intelligence Publisher 10.1.3.4. This section
provides information related to installing and configuring these reporting packages to work with
the Energy Information Platform, including:

* Installing Oracle Business Intelligence Publisher

*  Configuring Oracle BI Publisher

* Installing Crystal Reports 2008

*  Configuring Application and Web Servers for Crystal Reports 2008

Installing Oracle Business Intelligence Publisher

When using Oracle Business Intelligence Publisher (Oracle BI Publisher), you install the Oracle BI
Publisher software on a single application server. The Energy Information Platform application
and web servers that will be used to generate reports are configured to communicate with the
report server.

Note: The Oracle BI Publisher application can be installed either on an Energy
Information Platform application or web server, or on a “stand-alone” server.

Oracle Bl Publisher Installation
Download the Oracle BI Publisher installation program and documentation from the Oracle
eDelivery website (http://edelivery.oracle.com).

Install the Oracle BI Publisher software as described in the Oracle Business Intelligence Publisher
Installation Guide, Release 10.1.3.4.

During the installation:

*  Make a note of the name and path of the directory where the application is installed.
For example: BIPHomel / ¢:\OraHome_1

*  Select the “Basic” installation type.

*  Set your OC4] Administrator (oc4jadmin) password. Passwords must be a minimum of 5
characters, maximum of 30 characters, and include at least one digit.

Example: Lodestarl
*  Review your installation summary information:
* Install Directory: c:\OraHome_1
* Install Type: Oracle BI Publisher Basic
* Installed Components: Oracle BI Publisher
*  Administrator Username: oc4jadmin
*  Make a note of the URL used to access the Oracle BI Publisher application.
Example: http://MADEV2K30RVMO01:9704/xmlpserver
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Configuring Oracle Bl Publisher

This section outlines Oracle Business Intelligence Publisher configuration tasks required to enable

Oracle Business Intelligence Publisher to generate and display reports run through the Energy
Information Platform, including:

Start the Oracle BI Publisher Software
Log In to the Oracle BI Publisher Software
Create User for Reporting Framework

Set Report Path

Create Data Source for Oracle Utilities Data Repository

Note: if installing Oracle BI Publisher on the same machine as the Energy Information Platform

application server or web server software, install the Energy Information Platform software

before proceeding with the following tasks.

Start the Oracle Bl Publisher Software

The first step in configuring the Oracle BI Publisher software is to start the application.

To start the application, select Start->All Programs->Oracle-BIPHomel-Start BI Publisher.

A console (DOS) window opens on the desktop. Leave this window open in the background.

Log In to the Oracle Bl Publisher Software
Once the Oracle BI Publisher software is running, you must log in to the application to continue
the configuration tasks.

1.

Launch the BI Publisher application using one of the following methods:

From the Start menu, select Start-»All Programs->Oracle -
<ORACLE_HOME_NAME> -BI Publisher Server

where:

* <ORACLE_HOME_NAME)> is the name you gave the Oracle Home where you
installed Oracle BI Publisher.

From your browset, open your browset to http://<hostname>:<port>/xmlpsetrver
where:

*  <hostname> is the name of the server

*  <port> is the port where you installed Oracle BI Publisher

For example:

http://localhost:9704 /xmlpserver

Log in to the Oracle BI Publisher server using the default administrator user name and
password:

¢ User Name: Administrator

e Password: Administrator

Create User for Reporting Framework
You must create a BI Publisher administrator user on the Oracle BI Publisher server that the

Reporting Framework will use to connect to the BI Publisher server when users create, run, and

view BI Publisher reports.

To create a user, use the following procedure:
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6.

Navigate to the Admin tab, and click Users (under Security Center).

The User tab of the Security Center screen opens.

Click Create User.

The Create User screen opens.

Enter the User ID and Password for the user and click Apply.

The User tab of the Security Center screen now displays the new user.
Click the Assign Roles icon.

The Assign Roles screen opens.

Select BI Publisher Adminstator in the Available Roles box, and click Move.
The BI Publisher Adminstator role now appears in the Assigned Roles box.
Click Apply.

Refer to the Oracle BI Publisher documentation for more information about users and roles.

The User ID and Password for this user should be specified in the BI_ PUBLISHER/
CONNECTSTRING element in the LSReportMonitor.cfg.xml configuration file on each
application or web server on which the Reporting Framework will generate Oracle BI Publisher
reports.

Set Report Path

You must set the path to the diretory where the report template files are stored on the server.

To set the report path, use the following procedure:

1.

Identify the report templates folder on the Oracle BI Publisher server.

*  If the Energy Information Platform (and related products) is installed on this machine,
this is “C:\lodestar\bip.”

*  If Oracle BI Publisher is installed on a stand-alone server (a server where the Energy
Information Platform is NOT installed), create a directory for the report templates, and
copy the contents of the “C:\lodestar\bip” directory from an application server or web
server to the directory you created.

Navigate to the Admin tab, and click Report Repository (under System Maintenance).
The Report Repository tab of the System Maintenance screen opens.
Select File System from the Repository Type drop-down list.

Enter the path to the directory where the report templates are located (defined in Step 1
above).

Create Data Source for Oracle Utilities Data Repository
You must also create a JDBC data source on the Oracle BI Publisher to allow a connection to the
Oracle Utilities Data Repository. This is used when designing and testing reports.

To create a JDBC data source, use the following procedure:

1.

Navigate to the Admin tab, and click JDBC Connection (under Data Sources).
The JDBC tab of the Data Sources screen opens.

Click Add Data Source.

The Add Data Source screen opens.

Enter the following for the new data source:
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¢ Data Source Name: The name of the data source

*  Driver Type: Select the driver type from the drop-down list. Applicable driver types
include:

*  Oracle 11g
*  Oracle 10g
*  Microsoft SQL Server 2005

¢ Database Driver Class: the driver class for the data source. Should be one of the
following:

*  Oracle: “oracle.jdbc.OracleDriver.”
*  MS SQL Server: “net.sourceforge.jtds.jdbe.Driver” or full classpath of JDBC driver

*  Connection String: the connection string for the data source in one of the following
formats:

For Oracle data sources:

jdbc:oracle:thin:(@<ServerName>:<Port>:<YourDatabaseName>

where:
e <ServerName> is the machine name of the database server.
*  <Port> is the port the database connection will use. Default is 1521.

*  <YourDatabaseName> is the TNS service name used by the database’s ODBC
connection.

Note: If using Oracle 10g RAC, the connection string must specify the TNS entry for the
RAC connection. See Oracle BI Publisher Configuration for Oracle 10g R2 RAC on
page 2-14 in the Oracle Utilities Energy Information Platform Installation Guide for more
information.

For MS SQL Server data sources:

<DRIVER URL>://<ServerName>/<Database>

where:
*  <Driver_URL> is the URL of the JDBC driver
*  <ServerName> is the machine name of the database server.
*  <Database> is the database name.
*  User ID: the user ID for the database connection
*  Password: the password for the supplied user ID
4.  Click Apply.

The new data source appears on the JDBC tab of the Data Source screen.
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Installing Crystal Reports 2008

When using Crystal Reports 2008, you install the Crystal Reports software on each Energy
Information Platform application and web server that will be used to generate reports.

Note: The Crystal Reports software should be installed before the Energy
Information Platform software.

Crystal Reports 2008 Installation
Download the Crystal Reports 2008 (Service Pack 2) software and documentation from the SAP
website. The specific installation program required for use with the Energy Information Platform
is Crystal Reports Service Pack 2 - Click Once.

Note: Crystal Reports must be licensed separately.

Install the Crystal Reports software as described in the Crystal Reports installation
documentation.

Configuring Application and Web Servers for Crystal Reports 2008

This section outlines application and web server configuration tasks required to enable Crystal
Reports 2008 to generate and display reports run through the Energy Information Platform,
including:

*  Configuration for Windows 2003
*  Configuration for Windows 2008

Configuration for Windows 2003

Configuring Windows 2003 application and web services involves the following:

*  Grant Read and Write permissions for the “C:\windows\temp” folder to the NETWORK
SERVICE user.

Temp Properties ﬂ E
General I Sharing  Security | ‘wieb Sharing I Custarize I

Group or user names:
!ﬁ Administrators [MADAZK M 28\Adminiztiators]
€32 CREATOR OWNE

WICE
!ﬁ Power Users [MADAZK 3 255Power Uzers)

€7 SYSTEM -
1 |

Add... | Bemove |
Permissions for METWORE
SERWVICE Allow Deny
Full Control -
Modify

Read & Execute
Lizst Folder Contents
Read

write

=l
Crmmmi=l Demrrminmimma

Far special permissions or for adwanced settings, Advanced |
click Advanced. —

JIEREEEO
joooooo

QK I Cancel | Lpply |
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Configuration for Windows 2008

Configuring Windows 2008 application and web services involves the following:

*  Grant Full Control permissions for the “C:\windows\temp” folder to the NETWORK
SERVICE user.

. Permissions for Temp E
Security |

Object name:  C:\wWindowsA\Temp

Group or user names:
52 CREATOR OWwNER
52 SYSTEM

52, Administrators (MAGQAZKSWYM 264 Administrators)
52, Users [MADAZKEVM 264 sers)
SLIIS_IUSRS (MAQAZKEVMZENIS_IUSRS)

Add... | Remove |
Permissions for METWORE
RYICE Allow Deny
Full contral
Modify

Read & execute
Lizt folder contents
Read

HEEEE
OoOooon

j
=
Leam about access control and permissions

QK I Cancel | Apply |

Note: If the NETWORK SERVICE user does not exist, you must create this

useft.

*  Copy the libpng10.dll file from the Crystal Reports directory:
“C:\Program Files (x86)\Business Objects\Business Objects Enterprise 12.0\win32_x86”
to the “C:\LODESTAR\BIin” folder on the server.
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Chapter 3

Oracle Utilities Data Repository Schema

Creation

This chapter explains how to create the Oracle Utilities Data Repository schema, including,

Accessing the Database Creation Scripts

Schema Creation for Oracle 10g and 11g

Schema Creation for MS SQL Server 2008

Upgrading the Oracle Utilities Energy Information Platform Database Schema
Updating the Reporting Framework for Oracle Business Intelligence Publisher
Base Database Tables

Optional Schemas

Updating the LSGlobal Table

Later versions of the above RDBMS are generally supported when proven stable through Quality

Assurance testing at Oracle. Please contact technical support for information on which RDBMS

versions are currently supported. If your facility uses another type of database software, contact
Oracle.
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Accessing the Database Creation Scripts

The database creation scripts you will use to create the Oracle Utilities Data Repository database
schema are included in the Energy Information Platform installation package
(01.06.00.xx.00.EIP.zip). When the contents of the installation package have been extracted, the
database scripts are located in one of the following ditectories:

* . \DBScripts\EIP\Oracle\ (for Oracle databases)
e . \DBScripts\EIP\MSSQL\ (for MS SQL Setver databases)

Product-Specific Database Scripts

Some product require additional database tables in the Oracle Utilities Data Repository. These are
added via product-specific database scripts. These scripts are included in the product-specific
installation programs.

After being extracted from the installation package, the database scripts can be found using the
following path:

.\<PRODUCT>\<DB_TYPE>\<SCRIPT_TYPE>

where:

<PRODUCT> is the abbreviation for the product you are installing

<DB_TYPE> is the type of database platform you are using, Oracle or MS SQL Server
<SCRIPT_TYPE> is the type of database script you wish to access, Install or Upgrade

For example, to add the Oracle Ultilities Meter Data Management database schema to the Oracle
Utilities Data Repository, you would first extract the contents of the 01.06.00.xx.00.MDM.zip
file. The database scripts are located in one of the following directories:

*  .\DBScripts\MDM\Oracle\ (for Oracle databases)
¢ .A\DBScripts\MDM\MSSQL\ (for MS SQL Setver databases)
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Schema Creation for Oracle 10g and 11g

This section describes the steps required to create a Oracle Utilities Schema for Oracle 10g and
11g. These steps create the necessary tables for the Oracle Utilities Data Repository, as well as load
initial data. This section includes:

Schema Creation

Schema Creation
Data Loading
Number of Open Cursors on Oracle Server

ODBC Data Source Options

The base database schema consists of 180 tables, each of which has one or more constraints, and
possibly one or more indexes. The BUILDORA.CMD file included with your Oracle Utilities
installation is the top-level script used to initially create these tables. The syntax for this tool is:

buildora -1 <userid/password|/> [-d <database>] [-own <owner name>]

-opw <owner password> [-security]

Parameter Description

<usetid/password> The userID and password for a user with system
administrator privileges (a ¢/” can be used hete if OS-
authentication is supported)

<database> The service name given to the instance as specified in the
TNSNAMES.ORA file. and the ODBC DSN name of the
same database instance. This parameter is optional and if not
specified, the script will connect to the default Oracle
database.

<owner name> The name of the user which will own the database objects.
This parameter is optional. If not specified, the default user
PWRLINE will own the database objects.

<owner password> The chosen password for the PWRLINE schema owner.

The optional -security parameter specifies that the Security schema extension be installed with

the base schema. See Security Schema on page 3-20 for more information about this schema.

A log file named BUILDORA.LOG is created when the BUILDORA script is run. You should
check this log file for possible errors after running the script.
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Schema Creation in Advance Storage Mode
By default, the buildora.cmd script runs in basic storage mode. In basic storage mode tables,
indexes, and LOB segments placed in the default tablespace of the user that will own the database
objects.

You also can run the buildora.cmd script in advanced storage mode. In advanced storage mode
tables, indexes, and LOB segments will be placed in 3 different tablespaces. By default, the names
of these tablespaces are LSTAR_DATA, LSTAR_INDEX and LSTAR_LOB respectively.

How to run the buildora.cmd script in advanced storage mode:

1. Right-click on buildora.cmd and click EDIT. At the top of script you will see following lines:

rem KA AR A AR A KR A AR A AR A AR AR A A A A AR AR A AR A AR A A A AR A AR A A A AR A AR Ak,

rem Valid values for STORAGE MODE are BASIC and ADVANCED
Tem Kk kK ok ok ok ok ok ok sk ok ok ok ok ok ok ok ok ok ok ok gk ok ok ok ok ok ok gk ok ok ok sk ok ok ok ok ok ok ok ke ok ok ok ok ok ok ok ok ok ok ok

set STORAGE MODE=BASIC

set TAB TBLSPACE=LSTAR DATA
set IND TBLSPACE=LSTAR INDEX
set LOB TBLSPACE=LSTAR LOB

rem FEFFAAXX XA A AXX I A A A XX KR A A AA IR A A AA I IR AR I A I h AR XKk hhxxkkox

2. Change the STORAGE_MODE line from “BASIC” to “ADVANCED”

3. The default tablespace for tables is “LSTAR_DATA”. To change this, change the
TAB_TBLSPACE line from “LSTAR_DATA” to the desired name.

4. The default tablespace for indexes is “LSTAR_INDEX?”. To change this, change the
IND_TBLSPACE line from “LSTAR_INDEX” to the desired name.

5. The default tablespace for LOB segments is “LSTAR_LOB”. To change this, change the
LOB_TBLSPACE line from “LSTAR_LOB” to the desired name.

6. Save the changes and run the script.

Note: The buildora.cmd script does not create tablespaces for you. If you going to run the
buildora.cmd script in advanced storage mode, you should create proper tablespaces before
running the script.

Notes:
1. The name of the database objects owner must be 7 or less characters.

2. If your database objects owner is not PWRLINE, then you have to use the -q <owner name>
parameter in the command line for Oracle Ultilities applications, where <owner name> is
your database objects owner.

The script consists of the phases described below.

Phase 1: Schema Owner Creation
The BUILDORA script first creates the PWRLINE (or other user if specified in the -own
parameter) user with DBA privileges. The PWRLINE user is the owner of all of the database
tables. The script assumes that the name of the tablespace used to contain all data is USERS and
that there also exists a tablespace named TEMP which is used for temporary storage of data
required for sorting, index creation, and other functions. If this is not the case then this script
must be edited prior to schema creation to reflect the proper names of these two
tablespaces.

Note: The advisable storage space for testing databases recommended is 100
MB on USERS and 50MB on TEMP.
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Phase 2: PWRLINE_USER and LSSEC_ADMIN Role Creation
The BUILDORA script next creates two database role named PWRLINE_USER and
LSSEC_ADMIN.

The PWRLINE_USER role is granted read and write access to all of the tables. Any database
users who are subsequently created should be granted this role so that they too have read and
write access to the tables. However, the PWRLINE_USER role does NOT have permissions to
work with security database tables.

The LSSEC_ADMIN role is granted read and write access to the tables in the Security schema.
However, this role does NOT have permissions to work with other tables.

Phase 3: Base Schema Table Creation
The BUILDORA script next creates each of the 180 base database tables along with any
declarative constraints. The parent tables of all referential integrity constraints are created before
their respective dependent tables. See Base Database Tables on page 3-13 for the order in which
the tables are created.

All database tables are created in the default data tablespace of the PWRLINE (or other user if
specified in the -own parameter) user with default Oracle sizing parameters. If you decide that
these defaults are not appropriate for your database installation, the table creation script should be
edited prior to schema creation.

Phase 4: Loading Initial Required (Generic) Data
Oracle Utilities provides some lookup codes, as well as the base metadata required to initially
populate the database. This includes data for the following tables:

*  Units of Measure (UOM)

*  UOM Rate Quantities (UOMRATEQUANTITY)

*  Bill Determinants (BILLDETERMINANT)

*  Note Types (ACCTNOTETYPE)

* MV90 Status Code Map (MVIOSTATUSCODEMAP)
*  Report Lists (REPORTLIST)

*  Type Metadata (TYPEMETADATA)

*  Domain Metadata DOMAINMETADATA)

*  Table Metadata (TABLEMETADATA)

*  Column Metadata (COLUMNMETADATA)

*  Reference Metadata (REFERENCEMETADATA & KEYCOLUMNMETADATA)
* LODESTAR DB Version (LSDBVERSION)

*  Versioning Status (VERSIONINGSTATUS)

Phase 5: Schema Index Creation
The next phase of schema creation is the creation of additional indexes used to improve query
performance of various functions. Like the database tables, these indexes are also created in the
default tablespace of the PWRLINE user with default sizing parameters. If these defaults are
required to be changed then the script may be edited.

Phase 6: Loading LSGLOBAL dictionary
The next phase of schema creation is the loading of the LSGLOBAL dictionary. The LSGLOBAL
table holds the visible names of tables, references, and data types in xml format, and is required for
international support in Oracle Ultilities applications. You must update the LSGlobal table
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whenever metadata changes are made to the database. See Updating the LSGlobal Table on
page 3-21 for more information about updating the LSGLOBAL table.

Phase 7: Loading pre-defined Report Templates

Data Loading

The last phase of schema creation is the loading of pre-defined report templates used by the
Oracle Utilities Reporting Framework. See Chapter 13: Energy Information Platform
Reporting Framework for more information about report templates and the Reporting
Framework.

The Data Manager application provides graphical interfaces to add, edit, and delete data in the
Oracle Utilities Data Repository. It also provides access to the Import utility for bulk loading of
data from comma delimited, ASCII files. See the Data Manager Users Guide for more information.

The RSTATORA.CMD file included with your Oracle Utilities installation is the script used to
update statistics. After every major data load (approximately 20K records), run this script to
update statistics for optimal performance. The syntax for this script is:

rstatora [-d <database>] [-own <owner name>] -opw <owner password>

Parameter Description

<database> The name given to the instance as specified in the
TNSNAMES.ORA file. This parameter is optional and if not
specified, the script will connect to the default Oracle
database.

<owner name> The name of the user which will own the database objects.
This parameter is optional. If not specified, the default user
PWRLINE will own database objects.

<owner password> The chosen password for the PWRLINE schema owner.

A log file named RSTATORA.LOG is created when the RSTATORA script is run. You should
check this log file for possible errors after running the script.

Number of Open Cursors on Oracle Server

The following setting is needed in the init<sid>.ora (startup file):
Open_cursors = 1000

The above setting is a minimum. It can be more than 1000 if enough physical memory is available.
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ODBC Data Source Options

The following settings are needed in ODBC Data Source options on each client machine:

*  Enable LOBs = TRUE (checkbox is checked)

Oracle 8 ODBC Driver Configuration

oK
Data Source Mame |APL|DDH:L _
[ | |
Descrption I IEE
Hel
TNS Service Mame IAPUS_DHCL j 2 |
Test Connection |
User ID I

Application  Oracle IWorkaroundsl SQLServerMigrationl Tranzlation Dptionsl

Failower
Prefetch Court 10} Enable Failover v

Enable LOBs IV Rty |1U
Delay I‘ID

Enable
LOBs

*  Enable Query Timeout = FALSE (checkbox is unchecked)

Oracle ODBC Driver Configuration

]
DataSouics Name  [4PUBENT ook
C |
Description I ancel |
Enable —
TNS Service Name IAPU S_BENT j p

Query |- : |

imec Teat Connection |
Timeout Uszer 1D I

Application Workaloundsl SQLServerMigrationl Translation Dptionsl

Enable Result Setz [T PReadOnly Connection [

Enable Closing Cursors [ Enable Thread Safety W SOLGetData Extensions [

Batch Autocommit Mode ICommit only if all statements succeed j
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Schema Creation for MS SQL Server 2008

This section describes the vatious steps required to create a Schema for MS SQL Server 2008.
These steps create the necessary tables for the Oracle Ultilities Data Repository, as well as load
initial data.

Schema Creation

The base database schema currently consists of 180 tables, each of which has one or more
constraints, and possibly one or more indexes. The BUILDSQL.CMD file included with your
Oracle Ultilities installation is the top-level script used to initially create these tables. The syntax for
this tool is:

buildsqgl -d <dbname> -u <admin userid> -p <admin password>
[-s <server>] [-own <owner name>] -opw <owner password>
[-cxdb <TRUE |FALSE>] [-dnl <devicel number>] [-dn2 <device2 number>]

Parameter Description

<dbname> The name given to the database in the SQL server instance
<admin userird> The userid for a user with system administrator privileges.
<admin password> The password for a user with system administrator privileges.
<server> The name of the SQL server. By default this is the name of

the N'T server.

<owner name> The chosen username for the database schema ownet.
<owner password> The chosen password for the database schema owner.
<-crdb> If set to TRUE, the script will create a new database on the

sybase server with name specified in <dbname> parameter
and using values from the

<-dn1> and <-dn2> parameters like device numbers for new
database devices for this database.

If set to FALSE, the script will not create new database. The
script will connect to an existing database with a name
specified in <dbname> parameter and ignore values in the <-
dnl1> and

<-dn2> parameters.

A log file named BUILDSQL.LOG is created when the BUILDSQL script is run. You should
check this log file for possible errors after running the script.

Notes:
1. The name of the database objects owner can be 7 or less characters.

2. If your database objects owner is not PWRLINE, then you have to use the -q <owner name>
parameter in the command line for Oracle Ultilities applications, where <owner name> is
your database objects owner.

The schema creation consists of five phases which are described below.
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Phase 1: Schema Owner Creation
The BUILDSQL script first creates the PWRLINE user with DBO privileges. The PWRLINE
user is the owner of all of the database tables. The script assumes enough space on drive
containing the X:\Mssql\Data directory. If this is not the case, the sctipt must be edited ptior to
schema creation to reflect the proper Drive specification.

Phase 2: PWRLINE_USER Role Creation
The BUILDSQL script next creates a database role named PWRLINE_USER. This role is
granted read and write access to all of the tables. Any database users who are subsequently created
should be granted this role so that they have read and write access to the tables.

Phase 3: Base Schema Table Creation
The BUILDSQL script next creates each of the 180 base database tables along with any
declarative constraints. The parent tables of all referential integrity constraints are created before
their respective dependent tables. See Base Database Tables on page 3-13 for the order in which
the tables are created.

All database tables are created in the default data tablespace of the PWRLINE (or other user if
specified in the -own parameter) user with default Sqlcle sizing parameters. If you decide that
these defaults are not appropriate for your database installation, the table creation script should be
edited prior to schema creation.

Phase 4: Loading Initial Required (Generic) Data
Oracle Utilities provides some lookup codes, as well as the base metadata required to initially
populate the database. This includes data for the following tables:

*  Units of Measure (UOM)

*  UOM Rate Quantities (UOMRATEQUANTITY)

*  Bill Determinants (BILLDETERMINANT)

*  Note Types (ACCTNOTETYPE)

* MVI0 Status Code Map (MVIOSTATUSCODEMAP)
*  Report Lists (REPORTLIST)

*  Type Metadata (TYPEMETADATA)

*  Domain Metadata (DOMAINMETADATA)

*  Table Metadata (TABLEMETADATA)

*  Column Metadata (COLUMNMETADATA)

*  Reference Metadata REFERENCEMETADATA & KEYCOLUMNMETADATA)
* LODESTAR DB Version (LSDBVERSION)

*  Versioning Status (VERSIONINGSTATUS)

Phase 5: Schema Index Creation
The final phase of schema creation is the creation of additional indexes used to improve query
performance of various functions. Like the database tables, these indexes are also created in the
default tablespace of the PWRLINE (or other user if specified in -own parameter) user with
default sizing parameters. If these defaults are required to be changed, the script may be edited.
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Data Loading

Temp DB

The Data Manager application provides graphical interfaces to add, edit, and delete data in the
Oracle Utilities Data Repository. It also provides access to the Import utility for bulk loading of
data from comma delimited, ASCII files. See the Data Manager Users Guide for more information.

The RSTATSQL.CMD file included with your Oracle Utilities installation is the script used to
update statistics. After every major data load (approximately 20K records), run this script to
update statistics for optimal performance. The syntax for this script is:

rstatsql -d <dbname> [-own <owner name>] -opw <owner password> -s
<server>]

Parameter Description

<dbname> The name given to the database in the SQL setrver instance.

<owner name> The chosen user name for the schema owner.

<owner password> The chosen password for the schema owner.

<server> The name of the SQL sever. By default this is the name of the
NT server.

A log file named RSTATSQL.LOG is created when the RSTATSQL script is run. You should
check this log file for possible errors after running the script.

Temp db is required to store temporary database query results as well results of multiple sorts etc.
Make sure temp db is large enough to do the above process.

Temp db should be at least 50MB, either in RAM or on disk. Check with your system
administrator or SQL Server DBA for mote information.

Note: Do not use initial 2MB of temp db on master device.
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Upgrading the Oracle Utilities Energy Information Platform
Database Schema

If you are upgrading Oracle Ultilities Energy Information Platform from a previous version, you
must upgrade Energy Information Platform database schema. The following database upgrade
scripts are included in the Energy Information Platform installation package.

*  The updateEIP.cmd file. This database script updates the tables and data used by Oracle
Utilities Energy Information Platform in the Oracle Utilities Data Repository. This script can
only be used when upgrading the following schema version.

v1.6 Schema Version v1.6.1 Schema Version

v1.6.0.0.0 v1.6.1.0.0

If you are upgrading from a different schema version, contact Oracle Global Customer
Support.

Upgrading Oracle Utilities Energy Information Platform Schema

Open a command prompt and run the update EIP.CMD script. This script uses the following
syntax:

updateEIP [-d <database>] [-own <owner name>] -opw <owner password>

Parameter Description

<database> The name given to the instance as specified in the
TNSNAMES.ORA file. This parameter is optional and if not
specified, the script will connect to the default Oracle
database.

<owner name> The name of the user which will own Oracle Utilities database
objects. This parameter is optional. If not specified, the
default Oracle Utilities user PWRLINE will own database
objects.

<owner password> The chosen password for the PWRLINE schema owner.
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Updating the Reporting Framework for Oracle Business
Intelligence Publisher

If you are using Oracle Business Intelligence Publisher for reporting, you must update the pre-
defined reports in Reporting Framework database tables. The following database scripts are
included in the Energy Information Platform installation package for this purpose.

e The BIPEIP.cmd file. This script changes the pre-defined Energy Information Platform
reports from Crystal Reports to Oracle Business Intelligence Publisher.

Oracle Utilities Energy Information Platform Reports
Open a command prompt and run the BIPEIP.CMD script. This script uses the following syntax:

BIPEIP [-d <database>] [-own <owner name>] -opw <owner password>

Parameter Description

<database> The name given to the instance as specified in the
TNSNAMES.ORA file. This parameter is optional and if not
specified, the script will connect to the default Oracle
database.

<owner name> The name of the user which will own Oracle Utilities database
objects. This parameter is optional. If not specified, the
default Oracle Utilities user PWRLINE will own database
objects.

<owner password> The chosen password for the PWRLINE schema owner.

Verification - Energy Information Platform Reports

To verify that the Energy Information Platform reports have been updated, use the following
procedure:

1. Loginto the database using the PWRLINE user (Password =password).

2. Verify that the following records exist in the Report Instance table:

Report Name Description Report Type
WQAging Work Queue Aging BIPublisher
WQOpenByUser Work Queue Open Items

WQProductivity Work Queue Productivity BIPublisher
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Base Database Tables

The scripts used to build the database schema create the tables in the order listed below. These

tables are available when using Oracle.

ACCOUNT
ACCOUNTHISTORY
ACCOUNTNOTE
ACCOUNTSTATUS
ACCTBILLDETUSE
ACCTDIRECTORY
ACCTFACTORHIST
ACCTNAMEOVERHIST
ACCTINOTETYPE
ACCTOVERRIDEHIST
ACCTOVERRIDEREADY
ACCTOVERRIDEUSE
ACCTRATECODEHIST
ACCTRIDERHIST
ADDRESS
AGGREGATIONGROUP
AGSERVGRPHIST
BILLCODE
BILLDETERMINANT
BILLFREQUENCY
BILLFREQUENCYDATA
BILLHISTORY
BILLHISTORYVALUE
BILLHISTORYEDIT
BILLHISTORYEDITVAL
BILLHISTORYPROBLEM
BILLINGCYCLE
BILLINGCYCLEDATE
BLOCK

BLOCKING
BUDGETPLAN
BUDGETTYPE
CHANNEL
CHANNELGROUP
CHANNELHISTORY
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CHANSERVICEHIST
CUSTOMER
CUSTDIRECTORY
DESKTOP
DIRECTORY

ENDUSE

ENTINT

ENTPURPOSE

FACTOR
FACTORVALUE
GROUPCATEGORY
HOLIDAY
HOLIDAYLIST
INDUSTRIALCLASSIFICATION
INTERROGATION
INTERSCHEDMAP
JURISDICTION
LASTUID

LIST

LISTQUERY
LISTSTATUS
LISTRESULTS
LSACCOUNTTYPE
LSBREAKPOINT
LSCDVERSION
LSCONTACTTYPE
LSCURRENCY
LSCHANNELCUTDATA
LSCHANNELCUTHEADER
LSCHANNELCUTVMSGS
LSCHVERSION
LSDBAUDIT
LSDBAUDITCLOBS
LSDBAUDITUSERS
LSDBVERSION
LSFROMEMAIL
LSGLOBAL
LSINTDSTAGING
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LSINTDSOURCES
LSINTDVERCONTROL
LSPRODUCT
LSSPLASHMESSAGE

LSSPLASHMESSAGEEVENT

LSSESSIONINFO
LSTOUPERIODNAME
METER
METERHISTORY
METERREAD
METERVALUE
MVIOSTATUSCODEMAP
OPERATINGCOMPANY
OVERRIDE
PHYSICALRECORDER
PLANNINGAREA
PREMISE

RATECODE
RATEFORM
RATEFORMVERSION
RATEFORMVERTEXT
REBILLREASON
RECORDER

REGION
REPORTSETTINGS
REVENUECODE
RECORDERHISTORY
REPORT

REPORTLIST
REVENUE
REVENUEADEQUACY
REVENUESUMMARY
REVFORECAST
REVFORECASTITEM
SEASONDATE
SEASONPERIOD
SEASONSCHEDULE
SERVICE
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SERVICEPLAN
SERVICETYPE

SIC

SUBSTATION
TIMEZONE
TOUSCHEDULE
TOUPERIOD
TRANSFORMERLOC
TRANSFORMER
UOM
UOMRATEQUANTITY
USDAY

USDAYLIST

VERSION
VERSIONINGSTATUS

Meta-Data Tables

CATEGORYMETADATA
COLUMNMETADATA
DOMAINMETADATA
KEYCOLUMNMETADATA
REFERENCEMETADATA
TABLECATEGORYMETADATA
TABLEMETADATA
TYPEMETADATA

Security Tables

LSDATASOURCE
LSGROUP
LSGROUPPROFILE
LSGROUPTOKEN
LSPROFILE
LSPROFILETOKEN
LSSESSION
LSUSER
LSUSERACTIVITY

Report Framework Tables

LSRFBUSINESSUNIT
LSRFINTDHEADER
LSRFINTDVALUES
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Messaging Ta

Work Queues

LSRFRPTCATEGORY
LSRFRPTINSTANCE
LSRFRPTTEMPLATE

LSRFRPTTEMPLATEPRODUCT

LSRFRPTUNIT
LSRFRPTYPE

bles
BUSINESSCALENDAR
BUSINESSDAY
MESSAGEQUEUE
MESSAGETYPE
MESSAGETYPEQUEUE
SCHEDULEDMESSAGE
Tables

LSPROCESS
LSWQAPPRLEVEL
LSWQAPPRPROC
LSWQAPPRSTEP
LSWQCLOSEDACTION
LSWQCLOSEDITEM
LSWQCUSTPARAM
LSWQHINT
LSWQOPENACTION
LSWQOPENITEM
LSWQQUEUE
LSWQTYPE
LSWQTYPEHINT
LSWQTYPEPARAM

Interval Data Manager Tables

LSCEDITTRAILS

LSCHANNELCUTDATAA
LSCHANNELCUTHEADERA

LSIECDWSET
LSIECEDITWSET
LSIECHWSET
LSIECVMSGWSET
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Adapter Tables
*  BAGFVERSION

¢ BAGLOBALFUNCTION

«  BARDLVERSION

¢ BARULEDESCLANG

¢ BARULERDL

*  BATYPE

+  COMOBJECT

+  COMOBJTYPE

e HUBEXCEPTION

e HUBINBOUND

* HUBINBOUNDEXCEPTION

*  HUBMAP

¢ HUBMAPVER

+  HUBQUEUE

* HUBROWLOCK

« HUBRULE

« HUBRULETYPE

« HUBSERVER

* HUBSERVERSERVICE

* HUBSERVICE

« HUBSERVICETYPE

e HUBSEVERITY

e HUBSYSPROPS

e HUBSYSTEM

e ICEPAYLOAD

* ICEPAYLOADEXT

« ICEPAYLOADTYPE

« ICESTATUS

* JMSSERVER

*  XMLMAPSTORAGE
Service Point Tables

* LSACCOUNTREL

*  LSACCOUNTRELTYPE

e LSADDRESS

*  LSADDRESSFORMAT

*  LSCONTACT

*  LSCONTACTADDRESS
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LSCONTACTGROUP
LSCONTACTGROUPITEM
LSCONTACTPURPOSE
LSCONTACTMETHODTYPE
LSCONTACTMETHOD
LSMARKET
LSMARKETATTR
LSMARKETATTRTYPE
LSMARKETPARTICIPANT
LSMARKETPARTREL
LSMARKETPARTRELTYPE
LSMARKETPARTTYPE
LSMDBDVALUESP
LSORGANIZATION
LSORGCONTACT
LSORGCONTACTPURPOSE
LSPARTICIPANTTYPE
LSPREMISE
LSPREMISECONTACT
LSPREMISECONTACTPURP
LSSERVICEPOINT
LSSERVICETYPE
LSSRVCPTACCT
LSSRVCPTCONTACT
LSSRVCPTINVDETAIL
LSSRVCPTINVOICE
LSSRVCPTCONTACTPURP
LSSRVCPTMARKETATTR
LSSRVCPTMARKETPART
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Optional Schemas

After the creation of the base schema you can add the following schema objects to the Oracle
Utilities Data Repository:

*  Security Schema

Security Schema

The Security schema includes tables that store records used by the security functionality of the
Customer Choice Suite. See Chapter 12: Energy Information Platform Security for more
information. This schema is automatically included with the base schema, but can also be installed
as a stand-alone component. The “-security” switch is included in the buildora.cmd command line
to support this option.

Note: If the -security switch is present in command line and <owner name> is not PWRLINE or
specified by <owner name>, then the default user PWRLINE will be ignored and the default
security user LSSEC will own this schema (security database objects only). The “-audit” switch has
no effect if the “-security” switch is present in the command line.

Note: When installing the Security schema as a stand-alone component, be sure to specify the
correct data source and qualifier containing the Security schema in the LSSECURE.CFG.XML file
instead of the data source that contains the base schema. See LSSECURE.CFG.XML on page 2-
41 in the Oracle Utilities Energy Information Platform Configuration Guide for more information.
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Updating the LSGlobal Table

The LSGLOBAL table holds the visible names of tables, references, and data types in xml format,
and is required for international support in Oracle Utilities applications.

How to add/update LSGLOBAL table:

1.

3.

Locate the addLLSG.wsf script (included with your Oracle Ultilities installation) located in the
C:\LODESTAR\DB\Base directory created when you installed the Oracle Utilities
application software.

Note: Windows script host version 5.6 or above is required to run this script.
Double click the script.
The add.SG dialog opens.

i addL5G
Enter DSK, UserlD and Password, Eg.
DSM=0RCLUID=PwRLINE P D=PASSwWORD;

Cancel |

Enter Data Source Name, User ID and Password for the appropriate database schema in the
following format:

DSN=<database>;UID=<owner name>;PWD=<owner password>;

Parameter Description

<database> The name given to the instance as specified in the
TNSNAMES.ORA file. This parameter is optional and if not
specified, the script will connect to the default Oracle
database.

<owner name> The name of the user which will own the database objects.
This parameter is optional. If not specified, the default user
PWRLINE will own database objects.

<owner password> The chosen password for the PWRLINE schema owner.

Click OK.

The addLSG dialog prompts you to specify whether you want to create and load the
LSGlobal XML, or just create it.

i addL5G E
Enter 1 ta create and load »ML file inta Database oK
or 0 ko juzt create XML file _

Cancel |

Enter 1 to create and load XML file into the database, or 0 to just create XML file.

* Ifyou entered 1, to load XML file into database, you will see a dialog displaying
“updating LSGLOBAL”. Click OK.

* Ifyou entered O the dialog will Done.
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Maintaining the LSGlobal Table

You must update the LSGlobal table whenever meta-data changes are made to the database.

Multiple Language Support
Updating the LSGlobal table only creates English labels. Updating the L.SGlobal table for other
languages must be performed as a separate manual process.

First, the English xml file has to be generated using the addLSG.wsf script. Then the xml file is
edited for local language support and loaded to the LSGlobal table. Any meta-data changes after
this point must be added as a separate xml record in the LSGlobal table. Oracle recommends the
use of a source control application to track files added to the LSGlobal table.
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Chapter 4

Installing the Oracle Utilities Application

Note

Before you Begin

Software

This chapter describes installing the Oracle Ultilities application software on an application server,
client workstation machines, and web servers, and includes:

* Installing Oracle Utilities Energy Information Platform Software
*  Configuring Oracle Utilities Energy Information Platform Software

*  Upgrading Your Software

The installation of Oracle Utilities Billing Component and the Oracle Utilities Receivables
Component used here is for purposes of example only. The specific products that appear on your
installation screens may differ from those shown here.

Before you install your Oracle Utilities software, be sure that the following steps have been taken:

*  The Oracle Utilities Data Repository schema has been installed on the database server. Make
a note of the following information:

*  Data Source Name (DSN) for the database

*  Avalid User ID and Password for the database

* A valid Qualifier for the database

*  The Oracle database service name (if using Oracle)

*  The IP address or Host Name of the database server (if using MS SQL Server)

You will need this information when configuring your software to connect to the database.

*  RDBMS software has been installed on the application server and client workstation(s) where
you plan to install the software,

* A database connection has been set up between the database server and the application server
and client workstation(s).

*  Verify the ODBC / ODP dtiver installed on the web server is suppotted for the vetsion of
the software being installed. See Oracle Data Provider (ODP) Information on page 2-11
and ODBC Driver Information on page 2-11 for more information about supported
drivers.

See Chapter 2: Setting Up the Network Environment and Chapter 3: Oracle Utilities Data
Repository Schema Creation for more information about performing the above steps.
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Important Notes

The following are suggested practices for successful installation:

DO NOT use Terminal Services to install software: Use of Terminal Services to install
software is NOT supported (by Microsoft or Oracle Utilities). Installing Oracle Utilities
software using Terminal Services will result in errors. If remote installation is required,
Remote Desktop Connection can be used, under the following conditions:

*  The setver/workstation whete the softwate is to be installed is running either Windows
2003 or Windows XP.

*  The Remote Desktop client machine be running either Windows 2003 or Windows XP,
and must have the latest version of the Remote Desktop Connection client software
installed.

*  The client Remote Desktop Connection application must be launched with the “/
console” parameter on the command line.

Install directly on the server, with Full Administrative Rights: When installing web
software, ALWAYS install directly on the web server, with Full Administrative Rights, not
from another computer using console services. Doing otherwise can result in errors.

Use Default IIS Settings (no Security): When installing web software, make sure that IIS is
set to default security settings (i.e. NO security). Changing default IIS security settings may
result in errors. If IIS security must be applied, apply any security settings AFTER the Oracle
Utilities web software has been installed, configured, and tested.

DO NOT use Oracle names for user authentication: Oracle does not support Oracle
names with IIS. Use local TNS names only.

Stop Internet Information Services (IIS) prior to installing Oracle Utilities web-enabled
applications.

If using Crystal Reports, the Crystal Reports software should be installed before the Energy
Information Platform software.
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Installing Oracle Utilities Energy Information Platform Software

The following section details the steps involved in installing Oracle Utilities Energy Information

Platform application software on application servers, client workstations, or web servers,

including:

Install the Oracle Utilities Application Software

Install Oracle Utilities Language Packs (Optional)

Install the Oracle Utilities Application Software

To install the Oracle Utilities application software, use the following procedure:

1.

Navigate to the Install folder created from the Energy Information Platform installation
package (1.6.1.xx.0.EIP.zip). This folder contains the following files:

. Oracle Utilities EIP 1.6.1.xx.0.msi
*  sectup.exe

Note: If you wish to install other Oracle Utilities applications in conjunction with the Energy
Information Platform, expand the ZIP files for the applications you wish to install and move
the corresponding MSI files into the same directory as the Energy Information Platform files.
For example, if installing Oracle Utilities Billing Component along with the Energy
Information Platform, expand the "1.6.1.xx.00.BC.zip" file and move the "Oracle Utilities BC
1.6.1.xx.0.msi" file in to the same directory as the Energy Information Platform installation
files.

Note: Stop Internet Information Services (IIS) prior to installing Oracle Utilities web-
enabled applications.

Double-click the setup.exe file.

A dialog opens asking you to confirm the products you wish to install. Click Yes to continue
with the installation. Click No to cancel the installation.

When the Welcome screen appears, click Next.

The System Utilities Update Warning screen appears. This version of Oracle Utilities
software requires version 2.8 of Microsoft Data Access Components (MDAC).

To install the update of MDAC, select Yes, I want to install Microsoft Data Access
Components (MDAC) v2.8 and click Next. To return to the previous screen, click Back.
To cancel the installation, select No, I do not want to install Microsoft Data Access
Components (MDAC) v2.8’and click Next, or click Cancel.

Note: The System Utilities Update Warning screen only appears if MDAC
2.8 is not installed on the application server. If MDAC 2.7 is installed, the setup
skips this screen.

The Customer Information screen appears. This screen allows you to enter your user name
and organization. You also specify whether the software can be used by all users, or just the
user entered.

The user name and organization will be populated automatically. Select the appropriate users
under Install this application for: or select Anyone who uses this computer
(recommended) and click Next. To go back to the previous screen, click Back. To cancel the
installation, click Cancel.

The Destination Folder screen appears. This screen allows you to specify where the
software is installed on the machine.
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To install the softwate in the default directory (C:\LODESTAR), click Next. To change the
destination folder for the installation, click Change. The Change Current Destination
Folder screen appears.

Use the Browse button to navigate to the desired destination folder and click OK. This
returns you to the Destination Folder screen. Click Next to continue the installation. To go
back to the previous screen, click Back. To cancel the installation, click Cancel.

Select the type of installation you wish to perform. Available options include:
*  Web Server: All features will be installed, including web components

*  Configuration Client or Application Server: All features except web components will be
installed.

The Ready to Install the Program screen appears.

To install continue with the installation, click Install. To go back to the previous screen, click
Back. To cancel the installation, click Cancel.

The Setup Status screen will appear.
When the installation is complete, the Installation Completed screen will appear.

Click Finish.

10. After the installation is complete, you must restart your machine.

Directory Structure and Contents
The installation installs the files in the following directory:

C:\LODESTAR\

Once installed, the Oracle Utilities application directory contains the a number of subdirectories
which contain the following files:

BIN: Contains all files the Oracle Utilities application software needs to run, including
executables and .DLLs.

BIP: Contains report templates and other files used by Oracle Business Intelligence
Publisher.

BPEL: Contains files (jar files, XML files, and other files) used by BPEL web services used
by Oracle Utilities Meter Data Management.

Note: This directory is only installed if Oracle Utilities Meter Data
Management was installed.

CFG: Contains configuration files. When installed, this directory is empty, but sample
configuration files can be found in the C:\LODESTAR\ CFG\Examples\CFG directory.

FMEReports: This directory contains reports created through the Oracle Utilities
Receivables Component Reports feature. See Chapter 10: Reports in the Oracle Utilities Billing
Component Installation and Configuration Guide, 1olume II for more information.

Note: This directory is only installed if Oracle Utilities Billing Component was
installed.

LOG: Default location for all logging and error reports generated by the Logging
Framework.

LTMH: Contains files (executables, batch files, and .DLLs) used by the Oracle Utilities
Adapter.

RCDATA: Contains rate schedule and query files created by users.

USER: Contains various reports generated by the user.
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*  WEB: This directory contains the directories and files that comprise the Oracle Utilities
Energy Information Platform web user interface and other web-based applications.

Install Oracle Utilities Language Packs (Optional)

This section describes the installation of language packs for localized versions of Oracle Ultilities
applications. Language packs must be downloaded separately.

Pre-Requisites
Before installing a language pack, please make sure the following pre-requisite items are fulfilled.

1. Make sure all Oracle Ultilities products have been installed on the appropriate machines
(application servers, web servers, and client workstations).

2. Make sure an ODBC connection has been setup correctly and can access the database.

3. Make sure the user has administration (read and write) permission to access the Oracle
Utilities installation file folders. This is typically “C:\lodestat.”

4. Set the default script host to CSctipt by calling CScript //H:CSctipt.

5. Extract all files from the language pack zip file to a local (and accessible) folder.

Installation
The InstallLangPack script is used to install the language pack. This script is run from a command
prompt. To install the language pack, open a command prompt from the folder where language
pack files have been extracted and run the script.

The syntax for this script is as follows:

InstalllLangpack <dsn> <own> <opw> <LangCode> [<OUAppPath>]

where:

Parameter Description

<dsn> is the DSN for the Oracle Utilities Data Repository

<own> is the user ID for the database connection

<opw> is the password for the supplied user ID

<LangCode> is the Language Code. FRA - French, RUS - Russian, ITA - Italy, ARA
- Arabic, etc.

<OUAppPath> Optional. Oracle Ultilities application root folder. The default is

"C:\LODESTAR". If you installed the softwate in a different folder or
drive, please specify full path.

Example: Install the Russian language pack, connecting to a data source name called “local.”

InstallLangPack local trl05 password RUS

Installing the Oracle Utilities Application Software 4-5



Configuring Oracle Utilities Energy Information Platform Software

Configuring Oracle Utilities Energy Information Platform Software

After installing the Oracle Utilities software, the software must be configured to run propetly. This
section describes the steps required for basic configuration of the Oracle Utilities Energy
Information Platform softwarte, including:

*  Configuring an Application Server
*  Configuring a Client Workstation
*  Configuring a Web Server

Refer to the Oracle Utilities Energy Information Platform Confignration Guide for more information
about configuring the Oracle Utllities software.

Configuring an Application Server

After installing Oracle Utilities software on an application server, perform the following steps, as
needed.

Set Up Configuration Files on the Server
Oracle Ultilities application servers use the following configuration files.

LODESTAR.CFG
The LODESTAR.CFG file is a text file used to customize the working environment of the Oracle
Utilities application softwatre. See LODESTAR.CFG on page 2-2 for more information about
setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\Examples\CFG directory on each of the client workstations.

When configuring the software for use in a shared client-server configuration, copy the client
CFG file created when you installed the software on the application server to the
LODESTAR\CFG directory of each of the client machines.

LTMH.CFG.XML (optional)
The LTMH.CFG.XML file is a text file used to specify the database connection used by the Oracle
Utilities Adapter and Oracle Utilities Transaction Management. This file is required if the server
will be used to run the Adapter or Oracle Utilities Transaction Management. See
LTMH.CFG.XML on page 2-45 of the Oracle Utilities Energy Information Platform Installation and
Confignration Guide for more information about setting up this file.

LSRELAY.CFG.XML (optional)
The LSRELAY.CFG.XML file identifies the machine running an SMTP service used to send email
messages from the Oracle Utilities Energy Information Platform. This file is required only if the
email functions are used. The LSRELAY.CFG.XML file must be installed in the
C:\LODESTAR\CFG directory on each client workstation machine intended to execute the
EMAILCLIENT Rules Language function (see EMAILCLIENT Function on page 13-111 in
the Oracle Utilities Rules Langnage Reference Guide for more information). See LSRELAY.CFG. XML
on page 2-34 for more information about setting up this file. A sample of this file can be found in
the C:\LODESTAR\CFG\Examples\CFG directory on the web servet.

Sharing the LODESTAR Directory (optional)

Share portions of the LODESTAR directory with the client machine(s) that will use the Oracle
Utilities software.

*  To share the LODESTAR directory with all intended users of the Oracle Utilities software
(i.e. client machines), set the shared access to Full Control.

*  Modify the Share Name of the LODESTAR\RCDATA directory with an extension of this
directory matching the ODBC data source name, for example RCDATA. TEST2000.
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Note: This step is applicable only when configuring the software for use in a shared client-server
configuration. These steps are NOT required when using web-based products.

Modify the LODESTAR.CFG File (optional)

When running Oracle Utilities software in a server/client configuration there are two
distinct.CFG files used: the Server CFG file and the Client CFG file. For more information
concerning modification of the LODESTAR.CFG file and other configuration files, see Chapter
Six: Configuration Files.

Note: While this and other manuals refer to this file as the LODESTAR.CFG’
file (the default name of the configuration file), the actual name of the file can
be changed to match the name of the specific ODBC data source that will be
shared between the server and client(s).

Note: This step is applicable only when configuring the software for use in a shared client-server
configuration. These steps are NOT required when using web-based products.

Server CFG File
Copy the LODESTAR.CFG file from the C:\LODESTAR\Cfg\ examples\Cfg directory to the
C:\LODESTARN\Cfg ditectory, and edit it to add the following lines:

RCDATADIR=<DRIVE LETTER>:\LODESTAR\RCDATA.TEST2000

This configuration file is used by the server only.

Client CFG File
Create a copy of LODESTAR.CFG and modify the line RCDATADIR line as follows:

RCDATADIR=\\<MACHINE NAME>\<RESOURCE>\Lodestar\RCDATA.TEST2000

Note: MACHINE_NAME is the name of the server where the
LODESTAR.CFG file is located.

This file is used by all client machines.

Create a CISFORMT.TXT File (optional)
The next (optional) step is to create a file named CISFORMT.TXT file in the
C:\LODESTAR\CFG ditectory on the application server. This text file specifies the output
format of transaction records created by Oracle Ultilities Billing Component and other Oracle
Utilities applications. See Chapter 9: Creating a CIS Transaction Record Output File for more
information about setting up this file.

Install Interval Database Software
The last (and optional) step in setting up the Oracle Utilities software is to install Interval
Database software on the interval database server. The currently supported version of Interval
Database software is Pervasive.SQL 8.0. Refer to the Pervasive.SQL installation documentation
when installing this software.

Note: When using Pervasive.SQL, interval database files must reside on the
interval database server.
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Configuring a Client Workstation

After installing Oracle Utilities software on a client workstation, perform the following steps to
configure the software.

Set Up Configuration Files on the Workstation
Client workstations use the following configuration files.

LODESTAR.CFG
The LODESTAR.CFG file is a text file used to customize the working environment of the Oracle
Utilities application software. See LODESTAR.CFG on page 2-2 for more information about
setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\ Examples\ CFG directory on each of the client workstations.

When configuring the software for use in a shared client-server configuration, copy the client
CFG file created when you installed the software on the application server to the
LODESTAR\CFG directory of each of the client machines.

LSRELAY.CFG.XML (optional)
The LSRELAY.CFG.XML file identifies the machine running an SMTP service used to send email
messages from the Oracle Utilities Energy Information Platform. This file is required only if the
email functions are used. The LSRELAY.CFG.XML file must be installed in the
C:\LODESTAR\CFG directory on each client workstation machine intended to execute the
EMAILCLIENT Rules Language function (see EMAILCLIENT Function on page 13-111 in
the Oracle Utilities Rules Iangnage Reference Guide for more information). See LSRELAY.CFG. XML
on page 2-34 for more information about setting up this file. A sample of this file can be found in
the C:\LODESTAR\CFG\ Examples\CFG directory on the web servet.

Example:

<LSRELAY>
<EMAIL>
<EMAIL SERVER>bxqasrv5</EMAIL SERVER>
<EMAIL PORT>25</EMAIL PORT>
<EMAIL AUTH>LOGIN</EMAIL AUTH>
<EMAIL USER>Administrator</EMAIL USER>
<EMAIL PASS>lodestar</EMAIL PASS>
</EMAIL>
</LSRELAY>

Set Up Shortcuts to the Oracle Utilities Applications
The next step is set up shortcuts to the Oracle Utilities applications. You’ll want to set up a
shortcut for each Oracle Utilities application you have installed on each machine. At a minimum
this includes Data Manager, but may also include other Oracle Utilities products, such as Oracle
Utilities Billing Component or Oracle Utilities Rate Management.

Note: These instructions assume you are setting up shortcuts on the desktop.
If you wish, you can also modify the shortcuts on the Start Menu in the same
manner.

You should set up shortcuts for each Oracle Ultilities application on both the server and each
client machine.

1. Create a folder on the desktop. Create a shortcut in the folder and select DATAMGR.EXE
from the C:\LODESTAR\BIN directory. This is the shortcut to the Data Manager
application.

2. Modify the command line to include the following parameters (see Oracle Utilities
Application Command Line Parameters, below, for more information):

DATAMGR.EXE -1 -¢cTEST2000 -fC:\LODESTAR\CFG\LODESTAR.CFG (or server-
specific CFG file).
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Note: The first parameter is lower case ‘L, not numeric 1.
3. Double-click the Data Manager shortcut to open the program.

4. In Data Manager, select File->Browse->Customer Database to verify the database (in this
case, TEST2000) is visible by the application.

5. Select Tools->Options, and use the Interval Data Source tab to select an interval data
database file. Then select File-»Browse->Interval Data Database, and expand the
Recorder\Channel tree until you see a meter symbol. Click on any meter symbol to display
the load shape for that cut of data.

6. Copy the Data Manager icon to create shortcuts for any other Oracle Utilities products you
have installed, such as Oracle Ultilities Billing Component or Oracle Ultilities Rate
Management. Then click the r7ght mouse button and select Properties. Change
DATAMGR.EXE to the name of the program you ate installing (for example, PLBX.EXE
for Oracle Utilities Billing Component, RATEXPRT.EXE for Oracle Utilities Rate
Management).

7. Test each of these shortcuts by double-clicking on them to open the applications.

Oracle Utilities Application Command Line Parameters
Client/server applications use specific parameters to connect to the Oracle Utilities Data
Repository and other options. These parameters do not apply to web-based applications.

Command line parameters include:
-c <connectstring™> Specifies Data Source connection information, in one of the following formats:
For Oracle databases:

"Data Source=<data_source>;User
ID=<user_id>;Password=<password>; LSProvider=0DP;"

For Microsoft SQL databases:

"Data Source=<address>;Initial Catalog=<SQL database>;User
Id=<user_id>;Password=<password>;MultipleActiveResultSets=True;LSProvider=MSSQ
;"

where:

e <data_source> is the Oracle TNS Name for the data source, from the TNS_NAMES.ora file
(typically located in the \\ <machine>\oracle\network\admin directory)

e <user_id> is the user ID for the database connection

*  <password> is the password for the supplied user ID.

*  <address> is the IP address or Hostname of the MS SQL Server database server
*  <SQI_database> is the name of the MS SQL Server database

-q <qualifier> Specifies the database table qualifier (default is PWRLINE). If you supply this
parameter, it overrides the value specified for PLDBQUAL in the LODESTAR.CFG file. See
LODESTAR.CFG on page 2-2 of the Oracle Utilities Energy Information Platform Confignration Guide
for more information.

Note: All qualifiers used in the database must be uppercase.

-f <configfile> Configfile is the path and file name of a user-specific configuration file
(TEST2000C.CFG in the above example). The default file is LODESTAR.CFG. See
LODESTAR.CFG on page 2-2 for more information about this file.

-1 Display the Log On dialog before connecting to the database. The Log On dialog is also
displayed if there are PLDBQUALIFIERS in the LODESTAR.CFG file and the -q parameter is
not used.
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Note: This is the letter L. preceded by a dash (not the number 1). If you do not
supply this parameter, the logon dialog box does not appear.

-1 Run this application as a new instance, regardless of whether another one is running. Used to
connect to two different databases at the same time.

Note: This is the numeral 1 preceded by a dash (not the letter L).

-Ixxx  Specifies the language displayed by the application. The parameter (xxx) is a three letter
language abbreviation. Supported languages include DEU (German), ENU (American English),
FRA (French), and ITA (Italian).

-g If you supply this parameter, the program starts in debug mode (debug parameter is ON).
Default is debug parameter OFE See LODESTAR.CFG on page 2-2 of the Oracle Utilities Energy
Information Platform Configuration Guide for more information.

-nc If you supply this parameter, the program turns off catching fatal errors and displaying
Windows error messages. See LODESTAR.CFG on page 2-2 of the Oracle Utilities Energy
Information Platform Configuration Guide for more information.

Example:
C:\LODESTAR\Bin\datamgr.exe -c "Data Source=TS92;User
ID=LS470BX;Password=password;LSProvider=0DP;" -g LS470BX -1

Note: Each user of Oracle Utilities applications should have a unique user ID. Oracle Utilities
recommends that only one instance of each Oracle Ultilities application run on a workstation at a
time.

Using User-specified Configuration Files
Each Oracle Utilities application can be set to use other, user-specified configuration files. For
instance, you might want to change some configuration settings from the original CFG file. To do
this, edit the command line to refer to the specific application and/or configuration file you wish
to use, such as:

For path and file name: CA\LODESTAR\BIN\xxx.EXE
Optional Parameters: -fC\LODESTAR\CFG\MYOWN.CFG

If you do this, it’s best to rename the file with a meaningful name (such as USERNAME.CFG) to
help you keep track of each CFG file.

If a configuration file is not passed to the application software at startup, it will search for a file
named LODESTAR.CFG in the CFG directory. See Chapter Six: Configuration Files for
information about the use and customization of the configuration file.

Create a CISFORMT.TXT File (optional)
The next (optional) step is to create a file named CISFORMT.TXT file in the
C:\LODESTAR\CFG directory on the workstation. This text file specifies the output format of
transaction records created by Oracle Utilities Billing Component and other Oracle Ultilities
applications. See Chapter 9: Creating a CIS Transaction Record Output File for more
information about setting up this file.

Install Interval Data Database software on the client
The last (and optional) step is to install Interval Database software on the client machine(s). The
currently supported version of Interval Database software is Pervasive.SQL 8.0. Refer to the
Pervasive.SQL installation documentation when installing this software.
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Configuring a Web Server

After installing Oracle Utilities software on a web server, perform the following steps to configure
the software.

Set Up Configuration Files on the Web Server

Oracle Utilities web applications use the following configuration files.

LODESTAR.CFG
The LODESTAR.CFG file is a text file used to customize the working environment of the Oracle
Utilities application software. See LODESTAR.CFG on page 2-2 for more information about
setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\ Examples\CFG directory on the web servet.

Note: This file MUST be named LODESTAR.CFG on the web server.

LSSECURE.CFG.XML
The LSSECURE.CFG. XML file specifies the data source used by the Security functionality and is
required in order to run Oracle Ultilities web-enabled applications. The LSSECURE.CFG. XML
must be installed in the C:\LODESTAR\CFG directory. See LSSECURE.CFG.XML on page
2-41 for more information about setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\ Examples\CFG directory on the web servet.

Example:

<LSSECURE>
<DATASOURCE>
<NAME>DatabaseName</NAME>
<CONNECTSTRING>Data Source=TS92;User
ID=1s470bx; Password=password; LSProvider=0DP</CONNECTSTRING>
<QUALIFIER>DatabaseQualifier</QUALIFIER>
</DATASOURCE>
<EXPIRETIME>60</EXPIRETIME>
</LSSECURE>

Note: If an application server and web server are installed on different
machines, the LSSECURE.CFG. XML file is installed in the
C:\LODESTAR\CFG directory with the web Setver components.

LSREPORTMONITOR.CFG. XML (optional)
The LSREPORTMONITOR.CFG. XML file specifies where report data is stored and how
reports are processed through the web-enabled Customer Choice Suite. The
LSREPORTMONITOR.CFG.XML must be installed in the C:\LODESTAR\CFG ditectory.
See LSREPORTMONITOR.CFG. XML on page 2-35 for more information about setting up
this file. A sample of this file can be found in the C:\LODESTAR\ CFG\Examples\CFG
directory on the web server.

Example:

<LSREPORTMONITOR>
<DATASOURCE>
<NAME>DatabaseName</NAME>
<CONNECTSTRING>Data Source=TS92;User
ID=1s470bx; Password=password; LSProvider=0DP</CONNECTSTRING>
<QUALIFIER>DatabaseQualifier</QUALIFIER>
</DATASOURCE>
<PROCESS_POOL_SIZE>5</PROCESS POOL_SIZE>
<LOOP7TIMEOUT>5OOO</LOOP7TIMEOUT>
<REPORT_TYPES>
<REPORT TYPE NAME="PLBX" PATH="C:\LODESTAR\BIN\lsreport.exe"/>
<REPORT TYPE NAME="Crystal" PATH="C:\LODESTAR\BIN\crgenreport.exe"/>
<REPORT_TYPE NAME="LSIMPORT" PATH="C:\LODESTAR\BIN\lsimport.exe"/>
</REPORT7TYPES>
</LSREPORTMONITOR>
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Note: If an application server and web server are installed on different
machines, the LSREPORTMONITOR.CFG.XML. file is installed in the
C:\LODESTAR\CFG directory with the application server components.

LSLOGGER.CFG.XML (optional)
The LSLOGGER.CFG.XML file defines how log files are generated by Oracle Ultilities
applications. Each Oracle Utilities component can be configured to write messages to a specified
log file or an Event Log, The LSLOGGER.CFG. XML must be installed in the
C:\LODESTAR\CFG directory. See LELOGGER.CFG.XML on page 2-27 for more
information about setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\ Examples\CFG directory on the web server.

Note: If an application server and web server are installed on different
machines, the LSLOGGER.CFG. XML file is installed in the
C:\LODESTAR\CFG ditectory on both machines.

LSSCHDLR.CFG.XML (optional)
The LSSCHDLR.CFG. XML file defines the data source(s) monitored by the Oracle Ultilities
Schedule Service (LSSCHDLR.exe). This service monitors the Scheduled Message
(SCHEDULEDMESSAGE) table in each data source specified in this file. This file is required if
the Oracle Utilities Schedule Service is used. The LSSCHDILR.CFG.XML must be installed in the
C:\LODESTAR\CFG directory. See LSSCHDLR.CFG.XML on page 2-40 for more
information about setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\ Examples\CFG directory on the web server.

Example

<LSSHDLR>
<DATASOURCE>
<NAME>DatabaseName</NAME>
<CONNECTSTRING>Data Source=TS92;User
ID=1s470bx; Password=password; LSProvider=0DP</CONNECTSTRING>
<QUALIFIER>DatabaseQualifier</QUALIFIER>
</DATASOURCE>
<LOOP_TIMEOUT>5 00 O</LOOP7TIMEOUT>
</LSSHDLR>

Note: If an application server and web server are installed on different
machines, the LSSCHDLR.CFG. XML file is installed in the
C:\LODESTAR\CFG ditrectory on both machines.

LSRELAY.CFG.XML (optional)
The LSRELAY.CFG.XML file identifies the machine running an SMTP service used to send email
messages from the Oracle Utilities Energy Information Platform. This file is required only if the
email functions are used. The LSRELAY.CFG. XML file must be installed in the
C:\LODESTAR\CFG directory on the web server. See LSRELAY.CFG. XML on page 2-34
for more information about setting up this file. A sample of this file can be found in the
C:\LODESTAR\CFG\Examples\CFG directory on the web server.

Example:

<LSRELAY>
<EMAIL>
<EMAIL SERVER>bxgasrv5</EMAIL SERVER>
<EMAIL PORT>25</EMAIL PORT>
<EMAIL AUTH>LOGIN</EMAIL AUTH>
<EMAIL USER>Administrator</EMAIL USER>
<EMAIL PASS>lodestar</EMAIL PASS>
</EMAIL>
</LSRELAY>
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LTMH.CFG.XML (optional)
The LTMH.CFG file is a text file used to specify the database connection used by the Oracle
Utilities Adapter and Oracle Utilities Transaction Management. This file is required if the server
will be used to run the Adapter or Oracle Utilities Transaction Management. See
LTMH.CFG.XML on page 2-45 of the Oracle Utilities Energy Information Platform Installation and
Configuration Guide for more information about setting up this file.

LOCALES.CFG.XML
The LOCALES.CFG. XML file specifies the regional locales available to Oracle Utilities web-
enabled applications. The LOCALES.CFG. XML file must be installed in the
C:\LODESTAR\Web\CCS directory. A sample of this file can be found in the
C:\LODESTAR\CFG\ Examples\CFG directory on the web server. See
LOCALES.CFG.XML on page 2-22 for more information about this file.

Note: If the Report Server and Web Server are installed on different machines,
the LOCALES.CFG.XML file is installed in the C:\LODESTAR\Web\ccs
directory with the Web Server components.

Set Administration Login Password
Before logging on to the Oracle Utilities application, the administrator password must be set using
the LSSecurelnit.exe command line program. This program must be run on the web/application
server where the Oracle Utilities applications are installed. The syntax for this program is as
follows:

LSSecureInit -d <set_pw>

where:
Parameter Description
-d <set_pw> prompts the user to set a password for administrator login

(using the “admin” user ID) is to be set. The user is prompted to enter
and re-enter the password.

Create a CISFORMT.TXT File (optional)
The next (optional) step is to create a file named CISFORMT.TXT file in the
C:\LODESTAR\CFG directory on the web server. This text file specifies the output format of
transaction records created by Oracle Ultilities Billing Component and other Oracle Utilities
applications. See Chapter 9: Creating a CIS Transaction Record Output File for more
information about setting up this file.

Install Interval Data Database software on the server
The last (and optional) step is to install Interval Database software on the web server. The
currently supported version of Interval Database software is Pervasive.SQL 8.0. Refer to the
Pervasive.SQL installation documentation when installing this software.

Configuring an SMTP Email Server (Optional)
Use of the EMAILCLIENT Rules Language function and the Send Email function on the
View Reports screen of the Oracle Utilities Energy Information Platform web user interface
requires an SMTP (Simple Mail Transfer Protocol) server be set up and accessible by the machine
executing the email function. This is either an application server or client workstation executing
the EMAILCLIENT Rules Language function, or a web server. See Oracle Utilities Platform
Components Specifications on page 2-2 for hardwate/software requirements for each type of
machine.

The connection between the executing machine and the SMTP server is defined in the
LSRELAY.CFG. XML configuration file, which must be properly configured and present in the
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C:\LODESTAR\CFG directory of the executing machine. See LSRELAY.CFG.XML on page
2-34 for more information about this file.

Installing the Microsoft IIS SMTP Service
The Microsoft IIS SMTP service is a component of Microsoft Internet Information Services
(IIS), and is available with Windows 2003 Server and Windows XP Professional. If you wish to use
this service as your SMTP email server and this service is not installed on the web server (or client

workstation) you must install it.

How to install the SMTP service:

1.
2.
3.

Select Start->Settings-»Control Panel (or Start-»Control Panel for Windows XP).
Select Add/Remove Programs.

Select Add/Remove Windows Components.

The Windows Components Wizard dialog opens.

Check Internet Information Services (IIS) and click the Details button.

The Internet Information Services (IIS) dialog opens.

Check SMTP Service and click OK.

Click Next on the Windows Components Wizard dialog, and follow the instructions on the
wizard to complete the installation.

Configuring the Microsoft IS SMTP Service for Basic Authentication and Relaying
The next step in setting up the IIS SMPT email server is to configure the server for Basic
Authentication and Relaying.

1.

On the Desktop, right-click the My Computer icon and select Manage.

The Computer Management window opens.

In the Tree pane, expand Services and Applications and Internet Information Services.
Right-click Default SMTP Virtual Service and select Properties.

The Default SMTP Virtual Server Properties window opens. Select the Access tab.
Click the Authentication button.

The Authentication window opens.

Check the Basic authentication checkbox, and click OK.

Click the Relay button.

The Relay Restrictions window opens.

To specify a list of servers that can relay messages to the SMTP servet, select Only the list
below and add the web server to the Computers list (see step 9, below).

To allow any server except a specific set of servers to relay messages to the SMTP server,
select All except the list below and add the servers you wish to exclude to the Computers
list (see step 9, below).

To add a computer to the Computers list, click Add.
The Computer window opens.

To add a single computer, select Single Computer and enter the IP address of the computer
to be added, or click DNS Lookup to select the computer by its machine name.

To add a group of computers, select Group of Computers and enter the subnet address and
subnet mask for the group.

To add a domain, select Domain and enter the domain name.
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10.

11.
12.

Click OK. The specified computers will appear in the Computers list on the Relay
Restrictions window.

To allow all computers that successfully authenticate to relay messages to the SMTP server,
check the Allow all computers that successfully authenticate to relay, regardless of the
list above checkbox.

Click OK to save your settings.

Click OK on the Default SMTP Virtual Server Properties window.

SMTP Error Messages

Possible error messages related to the security access to the SMTP server are described below.

MSGRELAY0002: Unable to connect to the mail server. 535 5.7.3 Authentication unsuccessful.

Cause of Error: This error describes an attempt by the user to connect to the SMTP server
using the LOGIN security mechanism, but without a valid user name and/or password.

Resolution: Verify the user name and password in the LSRELAY.CFG. XML file, or create a
new user and password to the server’s user account list.

MSGRELAY0003L: Unable to send the email. 530 5.7.3 Client was not authenticated.

Cause of Error: This error describes an attempt by the user to send a email, without using
any authentication, on a SMTP server that requires this authentication before sending the
email.

Resolution: Provide a LOGIN authentication with a valid user name and password in the
LSRELAY.CFG.XML file.

Note: If users encounter problems emailing from a specific email server, keep in mind that email

servers can be configured to exclude users, domains or IP addresses from relaying email messages

on the server.
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Verifying the Installation

After the software has been installed and configured, you can verify the installation by following
the procedures outlined below, including:

*  Verifying Security Access
*  Verifying the Reporting Framework

*  Verifying the Report Scheduler

Verifying Security Access

Verifying security access involves testing that the Oracle Utilities web software can access security
data (data sources, users, groups, etc.) in the Oracle Utilities Data Repository. To verify security
access, use the following procedure:

1. Configure the LSSECURE.CFG. XML configuration file.

This file specifies the data source used by the Security functionality and is required in order to
run Oracle Utilities web-enabled applications. The LSSECURE.CFG. XML must be installed
in the C:\LODESTARN\CFG directory. See LSSECURE.CFG.XML on page 2-41 in the
Oracle Utilities Energy Information Platform Configuration Guide for more information about setting
up this file. A sample of this file can be found in the

C:\LODESTAR\CFG\ Examples\CFG directory on the web servet.

2. Login to the Oracle Utilities Energy Information Platform.
Open Microsoft Internet Explorer and enter the following address in the Address field:
http://<MACHINE_NAME> /lodestar/ccs
where:

e <MACHINE_NAME> is the name of the web server where the Oracle Utilities web
application server software is installed.

Enter the following credentials (case-sensitive):

User ID: admin

Password: lodestar

The Oracle Utilities Energy Information Platform welcome screen should open.

If the screen does not open, or if you see an error, verify the settings in the
LSSECURE.CFG.XML file. See Oracle Utilities Energy Information Platform
Diagnostics on page 14-6 in the Oracle Utilities Energy Information Platform Configuration Guide
for additional information about troubleshooting issues related to logging into the Oracle
Utilities web software.

3. On the Left Menu, select Tools and Utilities>Security Admin.
The Security Administration screen should open.
Do the following on the Security Administration screen:

*  Create a Data Source record. See Data Sources on page 7-21 in the Oracle Utilities Energy
Information Platform Users Guide for more information about Data Sources.

*  Create a User record. See Users on page 7-37 in the Oracle Utilities Energy Information
Platform Users Guide for more information about Users.

*  Grant all feature privileges to the User you just created for the Data Source you just
created. See Applying Function-Level Security on page 12-7 in the Oracle Utilities
Energy Information Platform Configuration Guide for more information about granting feature
privileges.
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3.

b.  Click the Logout icon to log out of the software.
Login to the Oracle Utilities Energy Information Platform using the new user you created.

All options on the Left Menu should be active and available.

Verifying the Reporting Framework

Verifying the reporting framework involves testing that reports can be run and viewed through

the reporting framework.

Note: Verifying the reporting framework requires that the correct reporting
software has been installed. See Installing and Configuring Reporting
Software on page 2-16 for more information.

To verify the reporting framework, use the following procedure:

1.

Configure the LSREPORTMONITOR.CFG.XML configuration file. This file specifies
where report data is stored and how reports are processed through the web-enabled
Customer Choice Suite. The LSREPORTMONITOR.CFG. XML must be installed in the
C:\LODESTARN\CEFG directory. See LEREPORTMONITOR.CFG.XML on page 2-35
in the Oracle Utilities Energy Information Platform Configuration Guide for more information about
setting up this file. A sample of this file can be found in the

C:\LODESTAR\CFG\ Examples\CFG directory on the web servet.

Login to the Oracle Utilities Energy Information Platform.

Open Microsoft Internet Explorer and enter the following address in the Address field:
http://<MACHINE_NAME> /lodestar/ccs

where:

¢ <MACHINE_NAME> is the name of the web server where the Oracle Utilities web
application server software is installed.

Enter the user ID and Password for the user you created in Verifying Security Access on
page 4-16.

The Oracle Utilities Energy Information Platform welcome screen should open.
Run the Work Queues Aging Report.
a.  On the Left Menu, select Work Queues>Run Reports.
The Run Reports screen should open, displaying three reports:
* WQAging
*  WQOpenByUser
*  WQProductivity
b. Click WQAging. The Report “WQAging” screen should open.
b. Click Run (do not enter report parameters).
The report should open in Adobe Acrobat Reader.

If the report does not run, verify that the Report Monitor service is running. See Energy
Information Platform Report Monitor on page 11-23 in the Oracle Utilities Energy
Information Platform Configuration Guide for more information about the Report Monitor
service.
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Verifying the Report Scheduler

Verifying the report scheduler involves testing that reports can be scheduled for execution and

recurrence. To verify the report scheduler, use the following procedure:

1.

Configure the LSSCHDLR.CFG. XML configuration file. This file defines the data source(s)
monitored by the Oracle Utilities Schedule Service (LSSCHDLR.exe). This service monitors
the Scheduled Message SCHEDULEDMESSAGE) table in each data source specified in
this file. This file is required if the Oracle Utilities Schedule Service is used. The
LSSCHDLR.CFG.XML must be installed in the C:\LODESTAR\CFG directory. See
LSSCHDLR.CFG.XML on page 2-40 in the Oracle Utilities Energy Information Platform
Configuration Guide for more information about setting up this file. A sample of this file can be
found in the C:\LODESTAR\CFG\Examples\CFG directory on the web server.

Login to the Oracle Utilities Energy Information Platform.

Open Microsoft Internet Explorer and enter the following address in the Address field:
http://<MACHINE_NAME> /lodestar/ccs

where:

e <MACHINE_NAME> is the name of the web server where the LODESTAR web
application server software is installed.

Enter the user ID and Password for the user you created in Verifying Security Access on
page 4-16.

The Oracle Utilities Energy Information Platform welcome screen should open.
Run/schedule the Work Queues Aging Repott.
a.  On the Left Menu, select Work Queues>Run Reports.
The Run Reports screen should open, displaying three reports:
* WQAging
e WQOpenByUser
*  WQProductivity
b. Click WQAging. The Report “WQAging” screen should open.
b.  Click Schedule Report (do not enter report parameters).
The Schedule Process: WQAging screen should open.

b. Enter the scheduled time for the report at 1 minute past the current time, displayed as
Server Time on the Schedule Process screen.

b.  Click Schedule. The View Reports screen should open (the WQAging report you ran in
Verifying the Reporting Framework on page 4-17 should be listed on the screen).

b.  Check the Show Scheduled Reports checkbox. The WQAGing report you just
scheduled should appear on the View Reports screen.

b.  Check the Refresh Periodically checkbox.
The report should run and open in Adobe Acrobat Reader.

If the report does not run, verify that the Report Monitor and Workflow Scheduler
services are both running, See Energy Information Platform Report Monitor on
page 11-23 and Energy Information Platform Report Scheduler on page 11-24 in the
Oracle Utilities Energy Information Platform Configuration Guide for more information about
these services.
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Upgrading Your Software

As new versions of Oracle Utilities, RDBMS, and Btrieve/Pervasive.SQL software become
available, you may want to upgrade to take full advantage of any new features or improved
performance offered. This section explains some of the issues associated with upgrading.

Upgrading RDBMS and Interval Data Database Software

Before upgrading your RDBMS software, be sure to check with Oracle to ensure that your Oracle
Utilities application software will work properly with the new version of your RDBMS. Later
versions of these RDBMS are generally supported when proven stable.

Before upgrading your interval data database software, check with Oracle to ensure that your
Oracle Ultilities application software will function properly with the new version of Pervasive
software.

Upgrading Oracle Utilities Software

Oracle releases software upgrades regularly. Customers are encouraged to upgrade to the newest
versions of our software after proper testing in their specific environments.

The following are some key points to keep in mind when installing an upgrade of Oracle Utilities
software:

*  Install the new software in a Test Environment. DO NOT INSTALL NEW SOFTWARE
OVER YOUR EXISTING PRODUCTION SOFTWARE. The Test Environment can
be established on a separate server/clients network (the preferred approach), or in different
directories on the same server/clients (for instance, C:\LODESTARTEST).

*  Create duplicate versions of your Oracle Utilities Data Repository for use in the Test
Environment, and rename them to clearly identify them as test versions of your data. This will
allow you to test the new software on valid data without affecting your production data. Be
sure to change the command lines on the new application shortcuts to point to the test
versions of your data.
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